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Notices ♦ iii

Notice to Canadian Customers

This Class A digital apparatus complies with Canadian standard 
ICES-003.

Notice to U.S. Customers

This equipment has been tested and found to comply with the limits 
for a Class A digital device, pursuant to Part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment 
generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from 
that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for 
help.

Note: Changes or modifications not expressly approved by Mitel 
Networks Corporation may void the user's right to operate the 
equipment.

Notice to Customers in EU Countries

We, Mitel Networks Ltd.
Of, Mitel Business Park
Portskewett
Caldicott
NP26 5YR
UK

Declare that for the hereinafter mentioned product the presumption of con-
formity with the applicable essential requirements 

of
DIRECTIVE 1999/5/EC OF THE EUROPEAN PARLIAMENT 

(RTTE DIRECTIVE) AND OF THE COUNCIL

is given.

Mitel / 5550 IP Console

Any unauthorized modification of the product voids this Declaration.

For a copy of the original signed Declaration of Conformity (in full 
conformance with EN45014), please contact the Regulatory 

Approvals Manager at the above address.

Complies with EN55022, EN55024, EN60950.

Note: This is a Class A product.
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Notices

These notices appear on the product and in the technical 
documentation:

Symbols

These symbols appear on the product:

WARNING Warning indicates a potentially hazardous situation which, if 
not avoided, could result in death or serious injury.

CAUTION Caution indicates a potentially hazardous situation which, if 
not avoided, may result in minor or moderate injury and/or 
damage to the equipment or property.

The exclamation point within an equilateral triangle indicates 
that important operating and maintenance (servicing) 
instructions are included in the literature accompanying the 
product.
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Introduction
The Mitel 5550 IP Console is an attendant console and administration 
application for the Mitel 3300 Integrated Communications Platform 
(ICP). It features a specialized keypad and an intuitive user interface 
for smooth, efficient call handling.

A note about feature availability

The features available on your telephone system (i.e. Mitel 3300 
Integrated Communications Platform) are automatically turned on.

Before you begin using the console

Take a few minutes to explore this guide — it contains all the 
information you need to operate the Mitel 5550 IP Console. 

The first section introduces you to the console. You will learn about 
the console keypad and what the Function keys on the computer 
keyboard do. You will also learn about the console screen and how 
to interpret the information it displays. 

If any problems occur while you are using the console, contact your 
communications department for assistance.

Conventions used in this guide 

Throughout this guide, the fixed-function keys and firmkeys (both key 
types are explained later in this section) are in bold type—for example, 
Answer or Release.

Softkey commands that appear on your screen and correspond to the 
Function keys (F1, F2, F3, etc.) at the top of your keyboard are shown 
in brackets— for example, [Source] or [Destination]. See page 7 for 
more information about softkeys.

Console Components
Your 5550 IP Console consists of a personal computer (PC) with 
monitor, a standard computer keyboard, a keypad, a mouse and a 
handset with cradle.

The monitor displays call-handling prompts and call status 
information. Use the keypad for all call-handling functions, including 
dialing. The handset (or optional headset) is for talking with callers.

You use the computer keyboard to find entries in the Phone Book or 
to type in the Scratch Pad or Bulletin Board. The Function keys (F1, 
F2, F3, etc.) at the top of the keyboard execute the softkey commands 
that appear on the screen.
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Console Screen
The 5550 IP Console screen is divided into six areas: 

Menu area  – provides alternate ways to access each of the other 
five areas of the Console screen. Select from the drop down menus 
or click the icon directly above the Console Status area to navigate 
to the display you wish to access.

Console Status area  – shows you at a glance what state the console 
and the system are in — for example whether the console ringer is 
on or off and whether the system is in Day or Night Service.

Application area  – includes three sections: 

• Queued Calls section (top left) is your main call-handling tool. 
It displays detailed call information for Incoming Calls, Calls on 
Hold, and Transferred Calls. Use these displays to answer, hold, 
and transfer calls, as well as to monitor call status and retrieve 
or recover a call.

Note: The tab that you last viewed before shutting down the 
console screen displays by default when you reopen the console 
screen.

• Tools section (top right) provides tools such as a Busy Lamp 
Field for obtaining the status (busy, idle, etc.) of selected exten-
sions and rapid dialing and transfering calls to those extensions. 
It also includes a Phone Book for finding users on the system. 

• Source and Destination sections (bottom left and bottom right) 
display the calling party and the called party for all calls handled 
by the console. The Source area shows the line on which you 
answered the call. The Destination area shows call forwarding 
information. The information displayed in both areas includes 
the name of the party, extension or trunk number or trunk label, 
type of extension, status of call (e.g., ringing), privileges as-
signed to the trunk or extension, and the type of call (e.g., 
Conference, Recall, Serial).

Call Waiting area – displays an icon ( ) as a visual indication of 
incoming calls. This area complements the Incoming Calls display in 
the Queued Calls area by allowing you to view at a glance the number 
and priority of calls waiting. The icon appears above the softkey that 
is used to answer the call. You can tell how many calls are waiting by 
the color of the icon: yellow ( ) for one call, blue ( ) for two calls, 
and red ( ) for three or more calls.

Softkey area  – displays Softkey commands. The commands 
correspond to the Function keys on the computer keyboard. See the 
next section for more information on the Softkeys.

Response area  – displays messages to alert you of system warnings 
and errors. It also indicates the date and time.



Getting Started ♦ 5

Questions about Resilient Talk State
What is Resilient Talk State?

Resiliency gives your network the ability to handle calls and provide voice mail
service in the event of a 3300 ICP system failure or a network-level failure. 
When a failure occurs, the 5550 IP Console goes into "Resilient Talk State" 
while it attempts to switch to a secondary 3300 ICP. All calls in talk state at the 
time of failure remain connected to the console. You will know that the console 
is in Resilient Talk State by the presence of icons (described below) in the 
Console Status area.

What is "fail over"?

"Fail over" occurs when the 5550 IP Console is in the process of connecting to 
a secondary or alternate 3300 ICP following a system failure. Note that call 
handling features such as Hold, Transfer, Conference and Page are not 
available during "fail over". Once "fail over" is complete, call handling features 
become available again. 

What does  in the Console Status area signify? 

The console is connected to the primary 3300 ICP and operating normally.

What does  in the Console Status area signify?

The console is connected to an alternate or secondary 3300 ICP—not the 
original or primary 3300 ICP.

What does  in the Console Status area signify?

Switching between 3300 ICPs is in progress. The console is in "fail over" state.

What does  in the Console Status area signify?

Repeated attempts to connect to a primary or secondary 3300 ICP have failed. 
The console will continue trying until a connection is established.

What do I do when the 5550 IP Console is in "fail over" state?

Take a message or ask the caller to call back later (fail over state usually lasts 
less than 30 seconds). Once the console has connected to a 3300 ICP,  will 
appear in the Console Status area, and you will be able to resume normal 
operation.
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Console Keypad
The console keypad is used for dialing, call processing and accessing 
3300 ICP features. You can adjust the slope of the keypad and detach 
it from (or attach it to) the handset cradle.

The keys on the keypad are arranged as shown below:

Volume and Mute Keys  – increase (+) or decrease (-) the ringer 
volume and the volume of the earpiece in the handset or headset. 
Mute turns the microphone in the headset or handset on or off.

Fixed Function Keys  – used to answer and manage calls. They 
include Retrieve, Hold, Answer, Cancel, Recover and Release.

Programmable Firmkeys  – programmable keys that provide access 
to the console features and system services listed in the following 
table.

Programmable Firmkeys
SCRATCH PAD Displays an electronic notepad where you can type 

messages from callers, reminders, questions, or 
anything else you would write on notepaper. Also, use 
the Scratch Pad to store numbers for speed dialing.

BULLETIN
BOARD

Displays an area where you can type messages that can 
be viewed from all 5550 IP Consoles on the system.

GUEST 
SERVICE

Displays room status information and softkeys for 
managing guest services in a Hotel/Motel installation. 

PAGER Accesses paging equipment for making announcements.

MESSAGE 
WAITING LAMP

Displays softkeys for setting or clearing the Message 
Waiting indicator on the dialed extension.

TONES Sends subsequently dialed digits as tones (used when 
dialing into voice mail systems.)

PHONE BOOK Allows you to find and call an extension by typing the 
user’s name, extension number or other information.

BUSY LAMP 
FIELD

Used to obtain the status (busy, idle, etc.) of selected 
extensions and lines and for rapid dialing and transfers.

INCOMING 
CALLS

Displays incoming calls with caller identity and called line 
details. Use to monitor and selectively answer calls.

HELD CALLS Displays caller and called party information for calls that 
you have held. Use to annotate and transfer held calls.

TRANSFERRED 
CALLS

Displays transferred calls that are ringing an extension. 
Monitor and retrieve calls that have not been answered.

VOICE MAIL Transfers a recall to an extension user’s voice mailbox.

EMERGENCY 
CALLS

Raises an alarm at the console when an extension user 
places an emergency call, and identifies the extension 
that placed the call. 

HELP Opens Help, which provides information to help you 
accomplish your tasks.

OPERATOR
MODE

Re-displays the main console screen.

THIRD PARTY 
APP

Launches specified third party application.



Getting Started ♦ 7

Note: Some of the features listed above are programmed for you by 
default; others are optional and may not be labelled on your keypad 
firmkeys. For keypad programming information, see Firmkey 
Programming on page 42.

Handset and Cradle

The 5550 IP Console is equipped with a handset and cradle. You can 
adjust the slope of the cradle and detach it from (or attach it to) the 
console keypad.

Mitel-approved headsets are also available for use with the console. 

See page 10 for more information about using the handset or a 
headset.

Keyboard Controls
Use the computer keyboard to search for Phone Book entries, type 
in the Scratch Pad or Bulletin Board, and execute softkey commands.

Softkeys (F1 – F12)

The softkeys are the F1 to F12 keys on your computer keyboard. You 
use them to enter commands shown in the softkey area on the screen. 
The commands are not fixed to a specific softkey; instead, they 
change depending on the state of the call you are handling or the 
feature you are using. For example, when you call a busy extension, 
the F4 key might be used to request a Callback. At another time, the 
same key, F4, could be used to set up a conference call.

Programmable Firmkeys
TRUNK STATUS Displays information about trunk (outside line) usage.

UNASSIGNED Allows you to program an unassigned (or “blank”) key to 
suit your calling needs.
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Starting and Closing the Mitel 5550 IP Console
The 5550 IP Console starts with the operator status set to “Operator 
Absent.” To begin receiving calls, you must change the status to 
“Operator Present.” For more information, see page 44. 

To start the 5550 IP Console

• Start Windows.

• Type your user name and password. 

• Click  on your Windows desktop.

To close the 5550 IP Console

• On the File menu, click Exit.

Tools for System Programming and Maintenance

The 5550 IP Console provides access to tools used to program and 
maintain the 3300 ICP. Access requires authorization (i.e., a user 
name and password) and is usually restricted to trained technicians. 

To access tools for system programming and maintenance

• On the File menu, click Connect to ESM or Connect to OPS 
Manager.

Questions about Starting and Closing the 5550 IP Console
What happens to incoming calls when I close the 5550 IP Console 
application?

If yours is the only console on the system, the system automatically switches 
to Night Service 1. Calls then ring night bells or another designated answering 
point. If there are other consoles, yours will switch to Operator Absent status 
when you close the application. Other answering points will receive the calls 
that would otherwise go to your console. For more information, see Day and 
Night Service on page 40 and Operator Status on page 44.

What happens to incoming calls when I minimize the 5550 IP Console 
window?

Calls still ring the console and can be answered by pressing the Answer key 
on the keypad. If the Screen Pop option (see page 36) is enabled, the console 
window also automatically maximizes.

What happens to calls if my computer stops working?

Usually, a nearby extension will serve as a backup answering position in the 
event of a power failure or other problem that causes your computer to stop 
working. Calls that normally ring the console would then ring the backup 
extension.

Can I use other applications while the 5550 IP Console is running?

Yes, but keep in mind that having multiple applications open at the same time 
as the console can adversely affect its performance. If possible, try to limit your 
use of other applications to periods when call traffic is low.

My screen goes blank sometimes—why?

A power-saving feature built into the computer automatically reduces the 
screen intensity when there has been no keyboard or mouse activity for 
approximately two minutes. After approximately five minutes, the screen goes 
blank. When you press the spacebar on the keyboard, the console screen will 
reappear.
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Adjusting the Console
The console is designed with your comfort in mind. You can make 
adjustments to the ringer, the language of text on the screen, the 
angle of the keypad, whether you want to handle calls using a handset 
or headset and more.

Console Ringer

To turn the console ringer on or off

• Select Ringer On or Ringer Off from the  list in the
Console Status area.

When the ringer is off, the Incoming Calls display and the call waiting 
icons ( ) provide the only indications that you have calls waiting.

To adjust the ringer volume

• While the console is ringing, press the    key on the console 
keypad to set the volume to the level you want.

You can also use the Options command on the Tools menu to adjust 
the ringer volume.

Console Keypad and Handset Cradle

You can adjust the slope of the keypad and detach (or attach) it from 
the handset cradle. The angle of the cradle also adjusts via the hinged 
attachment fitted to the back foot of the cradle.

To attach the handset cradle to the 
console keypad

• Align the tabs on the clamp 
with the slots on the bottom of 
the keypad.

• Press to seat the tabs in the 
slots.

To detach the clamp from the keypad

• Grasp the keypad as shown.

• Place your thumbs along the 
edge of the clamp, and then 
press down and away from the 
keypad.

To detach the clamp from the cradle

• Using your finger or a tool such 
as a screwdriver, push against ei-
ther of the tabs as shown.

• While pushing on the tab, use the 
other hand to twist the U-clamp 
upward.

WARNING: Bending your wrist while 
using the keypad for prolonged 
periods can cause physical injury. To 
minimize the risk of injury, adjust the slope of the keypad so that your 
wrist is straight.
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Handset/Headset

The console keypad provides jacks for connecting a handset and a 
headset. One jack is labeled for headset use only, the other for either 
handset or headset use. Both jacks can be in use at the same time 
but when they are, the dual-use jack is used for listening only. 
(Typically, a supervisor uses the dual-use jack to monitor a new 
attendant during training.)

Connect Mitel-approved headsets only to the keypad. For a list of 
approved headsets, see the 5550 IP Console Installation Guide. 

The dual-use jack provides different audio levels for headsets and 
handsets. Use the  list to indicate which one—headset or handset— 
is connected to the jack.

To set the dual-use jack for handset or headset operation

1. Plug the handset or headset into the dual-use jack ( ) on the 
back of the console keypad.

2. Select Handset or Headset from the  list in the Console Status 
area.

To adjust the handset (or headset) volume during a call

• Press the  key on the console keypad to set the volume to 
the level you want.

You can also use the Options command on the Tools menu to adjust 
the volume. After selecting the command (either during a call or while 
the console is idle) click Audio, and then drag the slider to set the 
volume to the level you want.

Console Language

Text on the console screen can appear in English (the default), 
French, Spanish, Dutch, Italian, or German. You can choose the 
desired language during installation.

To change the console language

1. Choose Options on the Tools menu.

2. Select Language.

3. Select the language you want.

4. Click Apply or OK.

The change takes effect when you restart the console. 

Console Time

You can use either the 3300 ICP clock or the clock in your PC as the 
time source for the console. Using the 3300 ICP clock is 
recommended since it’s the time source for extensions in the system. 

You should also use the 3300 ICP clock if you set wake-up calls for 
guests. (Setting wake-up call applies to hotel/motel systems only.) 

To set the console time

1. Choose Options on the Tools menu.

2. Select Time.

3. Select the option you want.

4. Click Apply or OK.

Unplugging the Handset or Headset
Unplugging the handset or headset from the console keypad automatically 
enables the other if it is plugged in. If neither is plugged in, the console changes 
to Operator Absent status. Or, if you are the last active attendant, the system 
goes into Night Service 1 mode.

Note that plugging the handset/headset back in does not change the Operator 
status back to Present. 

Unplugging the Handset or Headset
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Handling Calls in the Queued Calls Area 
You have access to three call-handling tools from the Queued Calls 
area of your console screen. Use these tools to manage queued calls: 

•  Incoming Calls – allows you to selectively answer calls. 
Incoming Calls shows recalls at the top of the list, then all other 
calls either in order of arrival, or in order of assigned call-answer-
ing priority (if you have specified line priority). You can answer 
calls in any order. See page 16 for details.

•  Calls on Hold – allows you to view, annotate, and transfer 
the calls you have put on hold. You can also use this display to 
remind you of caller identity details before you return to a held 
call. See page 23 for details.

• Transferred Calls – allows you to monitor and retrieve trans-
ferred calls that are ringing an extension. See page 21 for details.

You can customize each Queued Calls display by specifying which 
columns you wish to see, and by resizing each column. See page 38 
for more information.

Accessing the Queued Calls Displays

You can access any of the queued calls displays from the console 
screen or from a programmable key on your keypad.

1. Click the corresponding tab in the Queued Calls area

or
2. Click the corresponding icon ( ,  or ) in the Menu area

or
3. Select the Calls menu followed by Incoming Calls, Calls on 

Hold, or Transferred Calls
or

4. Press the associated programmable key on your keypad.
For information about programming keys, see page 42.

Monitoring Incoming, Held, and Transferred Calls

Use the queued calls display to view call information:

1. Access the appropriate queued calls display.

2. Scroll left or right using the scroll bar along the bottom of the 
display

or
3. Move the mouse pointer over the call. 

A pop-up like the one shown below appears and remains on 
screen for 10 seconds or until you move the pointer away from 
the call.
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Selecting Calls from the Queued Calls Displays

You can select calls using your mouse or your keypad.

1. Access the appropriate queued calls display.

2. Double-click on a call entry in the list

or
3. Press the Retrieve key, then enter the corresponding call ID digit 

(1-9) from the corresponding queued calls list.

If you wish to select an Incoming or Transferred call that has an 
ID digit of 10 or higher, double-click the call using your mouse.

Note: When you use the Retrieve key to answer a call, make sure 
that the correct queued calls display is selected (visible) on your 
console screen. For example, if you wish to select an incoming call, 
but press Retrieve and a call ID digit when the Calls on Hold display 
is visible, you connect to the held call with that ID digit.

Adding Notes to Calls in the Queued Calls Display

You can add notes to incoming and held calls, as well as annotate 
calls with the name, number, location, and Busy Lamp Field status 
of incoming and held calls. See page 23 for more information.

Questions about the Queued Calls Area
Why does my mouse pointer turn blue when I move it?

When you move your pointer over entries in any of the queued calls displays, 
the mouse pointer turns blue to indicate that the list has momentarily “frozen”.
The list “freezes” (that is, stops moving) to make it easier for you to select 
calls. This is especially helpful when your display is very active, with calls 
entering and leaving it rapidly.
To keep your list “frozen” for more than a second or two, continue to move 
your mouse pointer over the call entries as you decide which call to select.

Note: When your display is frozen, calls continue to queue. If you try 
to select from your frozen list a call that has already been answered 
while the list was frozen, a message indicates that the call is no 
longer beng queued (for example, “no call to retrieve”).

What do the icons ,  and , which appear on the Queued Calls 
tabs, indicate?

When an icon appears on a Queued Calls tab, the icon is your visual cue that 
you have selected that tab.

• appears on Incoming Calls

•  appears on Calls on Hold

•  appears on Transferred Calls

What does the number in parentheses in the Incoming Calls, Calls on 
Hold, and Transferred Calls tabs indicate?

The number that appears in parentheses on each of the Queued Calls tabs 
shows how many calls are currently queuing in each display. For example, 
Incoming Calls (3) shows that three incoming calls are being queued.

What does a flashing orange Queued Calls tab signify?

When a Queued Calls tab flashes orange, it alerts you that a call being queued 
requires your attention (for example, an incoming call has arrived, or a held call 
is recalling). The tabs will flash to alert you any time a call requires attention, 
even if you have not selected that tab.
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Answering Calls
When a new call arrives at the console

• the bell rings (if it is turned on),

• the call appears in the Incoming Calls display, and 

• a call waiting icon ( ) appears above the softkey associated 
with the call.

When you have incoming calls, your screen may look similar to this:

You can answer calls several different ways:

• Press Answer
or

• Press the corresponding softkey to selectively answer a call

or

• Select a call from the Incoming Calls display

or

• Press Retrieve and the call’s ID digit.

Note: You cannot answer a new call until the one you are engaged 
in is transferred, disconnected, or put on hold.

Answering Calls on a “First-come, First-served” or Line-Priority 
Basis

The Answer key has a “first-come, first-served” hierarchy: recalls are 
answered first, then all other calls either in order of arrival or in order 
of call-answering (line) priority. 

If you have assigned call-answering priority, the Answer key answers 
calls arriving on high-priority lines before calls arriving on low priority 
lines.

Note: To assign call-answering priorities to calls based on the 
telephone number that the callers dial to reach the console, see 
page 35.

To answer a call using the Answer key

1. Ensure both the Source and Destination areas are clear.

2. Press Answer.
Information about the call, such as the trunk name and number 
for an external call or the caller’s name and extension number 
for an internal call, is displayed in the Source area.
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Selectively Answering Calls

To select the call you want to answer, you can

• Press a softkey (for example, [Recall], [Dial 0], [External], 
[WATS], etc.) to select a call based on the line the call is arriving 
on

or

• Select a call from the Incoming Calls display to choose a call 
based on specific call details (such as caller name or number).

Answering calls using softkeys

If more than one call is waiting at a particular softkey, then the calls 
are answered on a “first-come, first-served” basis.

1. Use the icons ( ) in the Call Waiting area to help you decide 
which type of call to answer first. The icon appears above the 
softkey associated with the call type (external, recall, etc.). The 
number below the icon shows how many calls of that type are 
waiting. The icon color also shows how many calls of a particular 
type are waiting: yellow for one call, blue for two, and red for 
three or more calls.

2. Click the desired softkey.

In the example above, note that one [Recall] call, one internal [Dial 
0] call, and two external calls are waiting. You can press

• Answer to connect to the recall; or

• [Dial 0] to answer the internal call; or

• [External] to answer the outside call that first arrived at the 
console.

About the Call-Answering Softkeys
The call-answering softkeys are assigned by your communications 
department to suit the types of calls your company receives.

Ask your communications department which type of calls it prefers you to 
answer first.

The leftmost softkey is reserved for recalls (see Answering Recalls on 
page 35), but the other softkeys may be programmed in a variety of ways. For 
example, you might have softkeys labelled as follows:

• [Dial 0] and [External] to indicate whether a call is from outside the 
system or inside; or 

• [WATS] or [TIE] to tell you the type of trunk the call arrived on; or 
• The department name (for example, [Sales]) assigned to the trunk.

Use the softkeys to guide you when answering a call. 
For instance, when you see that a call is made from outside the system, your 
company might want you to answer with a different greeting than you use for 
internal calls or recalls. Use the form provided on page 61 to record your 
company’s preferred greetings.

You can also use the Incoming Calls display to guide you when answering 
incoming calls. See page 17 for more information about answering calls 
using the Incoming Calls display.
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Answering calls from the Incoming Calls display

You can use the Incoming Calls display to answer calls based either 
on call priority or caller identity.

When an incoming call arrives, view the call information that appears 
in the Incoming Calls display. 

The Incoming Calls display is customizable, so you can select the 
column of call information that you want to see, and you can re-size 
the columns to show more or less information. See page 38 for a list 
of the call information columns that you can view and customize.

For details on how to access the Incoming Calls display, see page 13.

To answer calls using the Incoming Calls display

1. Access the Incoming Calls display.

2. Double-click on a call entry in the list

or
Press the Retrieve key, followed by the corresponding call ID 
digit from the Incoming Calls list

or
Press the Answer key to answer the highest-priority call.

Note: To use the Retrieve key to answer an incoming call, ensure 
that the Incoming Calls display is selected (visible) on your console 
screen. See page 14 for details about selecting queued calls.

Questions about Answering Calls
Why do I sometimes hear a short burst of ringing while I’m 
handling calls?

Either a new call has arrived or a call on hold has recalled. As you are already 
handling a call, the console only rings once. You may turn down your volume 
control if you wish. You can also turn off the bell completely by using the    
list in the Console Status area. (NOTE: This also turns off all other bell 
indications except the Critical Alarm bell.)

What does the caller hear while I'm dialing the extension number?

Once you start to dial, the caller is on Consultation Hold until you have 
completed dialing, established communication with the called party, and 
released the caller to the called party. If music on hold is provided on your 
system, the caller will hear music; otherwise silence.

Can I answer another call while still connected to the first?

No. Before you can answer a new call, you must transfer the current call to 
another destination (see page 20), put it on hold (see page 23), or disconnect 
it from the console by pressing Release. 

Why do extension numbers appearing in the Source and Destination 
area sometimes have a  icon in front of them?

When it appears next to an extension, it means that the extension is designated 
as private. Attendants see the name and number of the extension on their 
screens; other extension users see “Private” on their display.
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Dialing Telephone Numbers
You can dial an internal extension number or the number of a 
telephone outside the system. Either the Source or Destination areas 
must be clear.

To call an extension

1. Dial the extension number from the console keypad.

Information about the extension appears in the Destination area. 
If information about an answered call is currently in the Destina-
tion area, that information moves to the Source area as soon as 
you start dialing.

2. Press Release
to release the call. If the extension is busy, the transferred call 
will automatically camp on to the line to wait until it becomes 
free. You can also handle the call in one of the following ways:

If the extension is busy

1. Press [Source]
and ask what the Source party would like to do. This leaves the 
Destination information displayed so that you can easily take a 
message and set Message Waiting on the destination extension, 
if required. (See Message Waiting on page 43.)

or
2. Press Cancel

to cancel the call. The caller remains in the Source area, but the 
information in the Destination area is lost, which makes setting 
Message Waiting more difficult. 

or
3. Press [Override]

to intrude into the Destination party’s call if permitted by your and 
the extension’s Class of Service (see Override on page 44).

To call an outside number

1. Dial the External Line Access Code ( ______ )1.

2. Dial the telephone number.

Information about the outside call appears in the Destination 
area.

Leaving a Callback

You can request a Callback after reaching a busy line (extension or 
trunk). The system monitors the line and rings the console when the 
line becomes free. Note that Callbacks on outside lines are used when 
all system trunks are busy, not when the called party is busy.

To leave a Callback after reaching a busy line

• Press [Callback].

Placing an Outside Call for an Extension

Extension users can usually place their own calls. However, they 
could ask you to place a call for them. Before dialing, you may want 
to note the extension’s COR number (see Class of Restriction on 
page 63). Check with your communications department for specific 
instructions on how to handle such requests.

To place an outside call for an extension

1. Answer the call from the extension.

2. Dial the External Line Access Code ( ______ )1.

3. Dial the telephone number.

4. Press Release
to release the call from the console and connect the extension 
to the outside line.

1  Use this space to record the digits you dial to access an outside line.
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Other Ways of Dialing

You can use the following alternate ways of dialing a telephone 
number:

Last Number Redial – instead of redialing the number of the last 
outside call you placed, let the system do it for you by dialing the Last 
Number Redial code ( ______ ).1

System Speed Call – allows you to dial a telephone number by 
entering a short access code. See System Speed Call on page 49.

Dial from Phone Book – useful when you don’t know the full name 
of the person you are asked to find or you only know the person’s 
location or department. See Phone Book on page 46.

Dial from the Busy Lamp Field (BLF) - displays a list of phones, 
with status icons beside them. You can use the [Call] button to dial 
any of these monitored phones. See Busy Lamp Field on page 32.

Dial from the Scratch Pad – allows you to dial a telephone number 
you typed on an electronic note pad. See Scratch Pad page 47.

Options

1 Use this space to record the digits you dial to access a specific trunk.

Questions about Dialing Telephone Numbers
Can I access a specific trunk?

Yes, you can select a specific trunk to dial out on.

• Dial the Individual Trunk Access Code ( ______ ).*
• Dial the trunk number. Trunk numbers can be 1 to 4 digits long.

• When you hear dial tone, continue dialing the telephone number.

If you hear busy tone, the trunk is in use. You can

• Press [Override] to interrupt the call in an emergency

or
• Press Release or Cancel to release the console from the trunk.

What do I do if I make a mistake while dialing?

If you notice the mistake before you complete dialing, press Cancel, and 
then re-enter the number.

If you realize you transferred a call to the wrong extension and you wish to 
cancel the transfer and reconnect the caller, you can 

• Press Recover
or

• Double-click the entry in the Transferred Calls list

See page 21 for more information.

Note:  You can recover a call that has been transferred, forwarded, 
and system-routed calls, as long as a call has not been answered 
at an extension. Once the call has been answered at an extension, 
you can no longer recover it.

* Use this space to record the digits you dial to access a specific trunk.
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Transferring (Extending) Calls
You can transfer a call to an extension or an outside number. Use the 
Transferred Calls display to view and retrieve a transferred call that 
is ringing an extension. 

When a transferred call is released, the call information appears in 
the Transferred Calls display. This display shows calls that have been 
ringing an extension the longest at the top of the list, and the most 
recently transferred calls at the bottom.

The Transferred Calls display is customizable, so you can select the 
columns of call information that you want to see, and you can re-size 
the columns to show more or less information. See page 38 for a list 
of the call information columns that you can view and customize.

To transfer a call

1. Dial the destination number.
The caller is automatically placed on Consultation Hold while 
you complete the transfer.

2. Press Release to connect the caller to the ringing phone.

3. If you wish, access the Transferred Calls display to view the call.

Note: If the called party fails to answer within a time-out period, the 
transferred call (if it is an outside line) returns to the console as a 
Recall.

Reaching a Busy Number or an Extension with Do Not Disturb 
Activated

If the dialed number is busy or the extension has Do Not Disturb 
activated, do one of the following: 

1. Press [Source]
to talk with the caller in Source without losing the Destination 
information. Tell the caller the requested number is busy and ask 
if the caller wants to try again later or leave a voice mail message 
for the busy party (see Options on page 19). You can also take 
a message and send the busy party a message waiting indication 
(see Message Waiting on page 43).

or
2. Press Cancel and then dial a different number 

if you think you can locate the requested party elsewhere

or
3. Press [Source], and then [Redial Dest]

to redial the same destination number

or
4. Press [Override]

to intrude into the extension user’s call (if permitted by your and 
the extension’s Class of Service. See Override on page 44.)

or
5. Press Release

to camp the caller on to the busy extension. (Camp-on is not 
allowed if the extension has Do Not Disturb activated.) The ex-
tension user hears two beeps to indicate a call is waiting. When 
the user hangs up, the extension rings and the waiting call is 
automatically connected.

Note: If there is no answer after a time-out period, the transferred 
call (if it is an outside line) returns to the console as a Recall. 
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Introducing the Caller before Completing the Transfer
After your call is answered and you’ve had the chance to speak with 
the person privately

1. Press Release to complete the transfer

or
2. Press [Source]

to speak privately to the party in Source; the party in Destination 
is on Consultation Hold. To speak privately to the party in Des-
tination again, press [Destination].

Transferring a Call to a Voice Mailbox
The Voicemail key on the console keypad allows you to

• Transfer recalls directly to an extension user’s voice mailbox.

You can use the key for transferring recalls only—that is, for 
transferring calls that have returned to the console because the 
extension went unanswered.

• Call the Voice Mail system directly.

After pressing the Voicemail key, manually enter the Voice Mail 
box number. The digit required (#) to trigger the Voice Mail sys-
tem to prompt for a Voice Mail box number is entered 
automatically. 

Note: For information on how to program the Voicemail key for one-
button transfers to Voice Mail, see page 42.

Transferring a Call to an Outside Number

You can request a meter pulse count for the call from the telephone 
company operator. Upon completion of the call, the console will ring. 
When you answer, the meter pulse count will display on the console 
screen. Ask your communications department for further information 
about this feature.

Retrieving a Transferred Call

You can retrieve a transferred call once the call appears in the 
Transferred Calls display.

If the Transferred Calls display is very active, keep your mouse pointer 
moving over the calls to “freeze” the list while you retrieve a call.

Note: If you try to retrieve from your frozen list a call that has already 
been answered while the list was frozen, a message indicates that 
the call is no longer being queued (for example, “no call to retrieve at 
specified transfer position”).

To retrieve a transferred call

1. Double-click the call entry in the Transferred Calls display list

or
2. Press the Retrieve key followed by the ID digit displayed in the 

Transferred Calls display, only if the transferred call ID digit is 
from 1 to 9. 
Retrieve call entries with ID digits greater than 9 using the dou-
ble-click method described above.

Note: When you use the Retrieve key to retrieve a transferred call, 
ensure that the Transferred Calls display is selected (visible) on your 
console screen. See page 14 for more details about selecting queued 
calls.



22 ♦ Call Handling Basics 

Questions about Transferring Calls
What do I do if the destination to which I am transferring a call is not 
answering?

• Press [Source] to reconnect the Source call and retain the Destination 
information. This gives you more options to handle the call because 
softkeys such as [Redial Dest] remain on screen.

or
• Dial a different number if you think you can locate the requested party 

elsewhere.

or
• Press Cancel to reconnect to the Source call but clear the Destination 

information.

Do I need to press Release when answering several calls in a row?

No. If you use the Answer key to answer calls, pressing Answer transfers 
the current call to the dialed destination and connects you to the next call 
waiting. This only works if you have calls in both Source and Destination 
areas.

What do I do if a caller wants to speak to one person, and then another?

If an outside party wants to speak with several people in a row, use the Serial 
Call feature (see page 47). When the outside party completes the first call, 
you receive a Recall and can then dial the next person’s number.

Can I transfer a call to another console?

Yes, by dialing the extension number of the other console. You can transfer 
calls to other consoles but you cannot put another attendant on hold.

Can I add a note to a call in the Transferred Call display?

No. Because the Transferred Calls queue is so dynamic (calls enter it and 
leave it rapidly), you cannot add or edit notes for calls in this display.
However, you can annotate a call by adding a note while the call is in the 
Source area or the Calls on Hold display.

Is there an easy way to double-click on a transferred call when the 
Transferred Calls list is changing rapidly?

Yes, you can freeze the list. See page 14 for more information. 
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Holding Calls and Retrieving Held Calls
You can place up to six callers on hold while you check for information 
or page the person that the caller is requesting. 

When a call has been placed on hold, the held call information 
appears in the Calls On Hold display.

The Calls On Hold display is customizable, so you can select the 
columns of call information that you want to see, and you can re-size 
the columns to show more or less information. See page 38 for a list 
of the call information columns that you can view and customize.

To place a call on hold

• Press Hold.

To retrieve a call on hold

You can retrieve a call on hold only when the Source and/or 
Destination area on the screen is clear:

1. Press Retrieve, and dial the position number of the call (1-6) 
you want to retrieve

or
Double-click the entry in the Calls on Hold display

or
Press Retrieve and then the star key (*) on the keypad to retrieve 
the longest-held call.

2. Speak to the caller.

3. Press [Dial DEST] to release the call to the original Held For 
party, if the caller wishes to try to reach that person again.

Note: If you have annotated or added notes to the call, refer to those 
notes so that you don’t have to ask again for the caller’s name or the 
name of the person the caller wishes to reach. See “Annotating Calls” 
on page 23 for details.

Annotating Calls

Annotating calls on hold allows you to keep track of multiple held calls 
and handle them more efficiently. 

Record specific call information (for example, “Urgent!”) using the 
Notes field in the Source, Destination or Calls on Hold areas. These 
notes stay with the call until you release the call to the extension that 
the caller is trying to reach, or until the call returns as a recall.

Annotate calls on hold with “Hold For” information using [Hold For] 
in either the Phone Book search results area or the Busy Lamp Field 
area.

To add a note to an incoming or held call

1. Answer or retrieve the call.

2. Click the Notes field in one of these areas:

- Source area (that is, while you are speaking with the caller), 
or

- Destination area (that is, while you are speaking to the per-
son the caller wishes to reach), or

- Calls on Hold display (that is, after you have held the call).

3. Type the desired message, and press

- ENTER to accept the message, or
- ESC to cancel the message that you typed.

4. Press Hold.
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To annotate a call on hold

Use [Hold For] to hold a call and annotate it with called-party 
information. 

1. Select the call from the appropriate Queued Calls display.

2. Click once on the desired extension from Busy Lamp Field list 
or the Phone Book.

3. Press [Hold For] to annotate the call.

The console adds the name and number of the person that the 
caller is trying to reach, as well as the current state of that line 
(for example, busy) to the call record.

For example, in the following case, the console annotates the call: 

• A caller in the Source area requests a transfer but the extension 
dialed from the Phone Book or Busy Lamp Field list selection is 
busy or not answering.

• Press Cancel, then [Hold For]. The held call is automatically 
annotated with extension user's name and number. 
If the extension is in the BLF list, then the department, location 
and line state are also added to the annotation.

Note: The system automatically annotates calls with “hold for” 
information when you press Hold immediately after attempting to 
connect a caller to an unanswered or busy extension. See “Questions 
about Hold and Retrieve” on page 25 for more details.

Hold Recall

The Calls On Hold display can show two timers for each call on hold:

• The Total timer begins counting when the call first arrives at the 
console. It indicates the total duration of the call. 

• The Time timer begins counting when you place the call on hold. 
It indicates how long the caller has been on hold. The timer is 
reset to zero each time the call is retrieved and placed on hold.

The Time and Total times are limited to 99:59 (minutes:seconds).

Calls that are left on hold longer than the limit determined by system 
programming recall to the console. When a call recalls, its ID and hold 
Time values turn bold and alternate between the default colors (black 
or white) and orange. The Total time value for the calls also turn bold. 
Answer recalls using the procedure for retrieving a call on hold.

To connect a call on hold to the Source or Destination party

1. Press Retrieve and dial the position number of the call (1-6) you 
want to retrieve

or
Double-click the call you want to retrieve in the Calls on Hold 
display.

2. Press [Source] or [Destination] if you want to speak privately 
to either party.

3. Press Release to connect the parties and release the console 
from the call.

Options
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To connect two calls on hold

Be sure the Source and Destination areas are both clear.

1. Press Retrieve and dial the hold position number of one of the 
two calls that you wish to connect

or
Double-click the call in the Calls on Hold display.

Information about the call appears in the Source area.

2. Repeat Step 1 to retrieve the other of the two calls you wish to 
connect. Information about the call appears in the Destination 
area.

3. Press [Conference] to connect the calls and [Hold] to hold the 
call

or
4. Press Release to connect the calls and release the console from 

the call.

Note: If you wish to hold the connected call, and want the 
connected call to include one note from one of the two original 
calls, press [Swap Notes] after you press [Conference] and 
[Hold]. The selected note is bold. The note to be discarded is 
greyed out. [Swap Notes] appears only if both calls contained 
notes, and only after you have connected and held the call. The 
selected note is bold. The note to be discarded is greyed out.

Questions about Hold and Retrieve
What’s the fastest way to annotate a call with the name and number of 
the person a caller is trying to reach?

If you cannot connect a caller in the Source area to an extension in the 
Destination area either because the line is busy or the called party is not 
answering, press Cancel and Hold. The console automatically annotates the 
call with the name and number of the extension to which you last attempted 
to connect the call. See Annotating Calls on Hold on page 23 for more ways 
to annotate calls.

Can I place a conference on hold?

Yes. If you can’t find a person needed for the conference, you can place the 
conference on hold until you locate the person. For details, see page 26.

If I make an error when adding a note to a call in the Source or 
Destination area, can I “undo” the note?

Yes, you can. If you have not yet pressed ENTER when adding a note to the 
Notes field, press ESC to cancel the message you have typed and begin a 
new message.
If you notice an error in the Notes field after you have pressed ENTER, you 
can edit the note by clicking on it. Correct the error and press ENTER to re-
save the edited note.

Is there a limit to how long a note can be?

The notes fields in the Source and Destination areas accept up to 50 
characters.
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Conference Calls
Up to eight parties (including yourself) may be connected to form a 
conference call.

To set up a conference call

• With the two parties connected to the console—one in the 
Source area and the other in the Destination area—press 
[Conference].

To split a conference to speak privately to either caller

• Press either [Source] or [Destination].

To add more parties to a conference

1. Dial the number of the next party.

The word “Conference” and a Conference number now appear 
in the Source area, and the number of the dialed party appears 
in the Destination area.

2. Press [Conference].
The new party is added to the conference. The parties already 
in the conference hear a brief tone each time a party is added.

If the line is busy or unanswered or the person is unavailable

• Press Cancel.
to reconnect to the conference. You may continue dialing to add 
more parties to the conference.

To release the console from the conference

• Press Release.

Once you release the conference, you cannot re-enter it.

Placing a Conference on Hold

If you can’t find someone needed for the conference, you can place 
the conference on hold until you are able to locate the person.

To place a conference on hold

1. Press Hold.

The conference is on hold. The parties in the conference can 
speak to each other—only you are removed from the call.

2. Check on the conference periodically, because the parties in the 
conference cannot get in touch with you.

To retrieve a held conference

You can retrieve a conference only when the Source and/or 
Destination area on your screen is clear.

1. Press Retrieve and dial the call ID number of the held 
conference

or
2. Double-click the held conference from the Calls on Hold display.
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Answering Recalls
If an external call transferred from the console to an extension is not 
answered within a certain time, the call returns to the console as a 
recall. The call waiting icon ( ) appears above the [Recall] softkey, 
and the call appears with highest priority in the Incoming Calls display. 

Because Recalls are given priority, they are answered first when you 
press Answer.

To answer a Recall

The Source and Destination areas must both be clear.

1. Press [Recall]
or

2. Press Answer.
You are now connected and may ask if the caller wants to con-
tinue waiting or wants you to ring another extension.

Note: Any notes that were added to the call prior to its returning 
as a recall no longer appear. If you wish, you may annotate the 
call again (see page 23 for details).

3. Depending on what the caller wants, you now have several 
options:

• Press [Redial Dest] if the caller wants to continue 
waiting.

• Dial another extension.

• Press Release to disconnect the call.

• Press Voicemail to transfer the caller to the extension's 
voicemail box.

Note: Serial calls will also recall the console. See Serial Call on 
page 47.

Recovering a Call
You can recover a call that you released to the wrong extension in 
several ways.

To recover the last call released from the console

Use the Recover key on the console keypad to retrieve a call that 
you just released to the wrong extension. 

• Press Recover.
Note: To successfully recover the call, you must press Recover 
while the extension is still ringing, and you cannot have started 
another action such as dialing or answering a call before 
pressing Recover.

To recover a call that is not the last call you released from the console

You can recover a released call if it still appears in your Transferred 
Calls display. See Retrieving a Transferred Call on page 21.

To recover a call that is ringing an extension in the Busy Lamp Field

If a call is ringing an extension in the Busy Lamp Field (BLF) area, 
and the extension is busy, not answering, or you know that the called 
party is not available, you may wish to recover that call to speak to 
the caller directly.

With your console in idle state (that is, with no calls in either the Source 
or Destination areas):

1. Ensure the extension in the BLF list is ringing—one of these 
icons is displayed beside it:  or .

2. Click once on the ringing extension to select it.

3. Press [Pick Up].
Note: If one or more attendants is attending calls with you, be sure 
that you don’t pick up a ringing call that another attendant has just 
placed. For more information, see page 32.
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Account Codes
An Account Code is a type of password for the system. You may need 
to enter an account code to access certain features or to record a call 
on the SMDR log for billing or accounting purposes.

To enter an Account Code

1. Dial the Verified or Non-Verified Account Access Code.

A Verified code provides access to features; a Non-Verified 
Code records calls on the SMDR log.

2. Dial the Account Code, ending in #.

If you make a mistake, press Cancel and try again.

3. Continue dialing.

For more information about Account Codes, contact your 
communications department.

Bulletin Board
The Bulletin Board is shared by all 5550 IP Consoles on the system. 
Use it to post information that you want other attendants to see and 
to store speed dial numbers that all attendants can access. 

To post information on the Bulletin Board

1. Press Bulletin Board.

2. Press [Edit].
Only one person at a time can edit the Bulletin Board; if someone 
else is editing it, the Bulletin Board background will remain gray 
after you press [Edit].

3. Type the information you want to post.

4. Press [Save]. 
To view the most recent changes to the Bulletin Board, press 
[Refresh].

To dial a telephone number posted on the Bulletin Board 

1. Select the telephone number using the mouse or the computer 
keyboard. 

2. Press [Call] or double-click the selected number.

Note: Information posted on the Bulletin Board is stored in a file on 
your network. The actual location of the file is determined during 
installation of the console. If the file is moved, enter the new location, 
using the Options command on the Tools menu.
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Busy Lamp Field (BLF) 
Busy Lamp Field (BLF) is an optional feature that allows you to 
monitor the status of extensions and lines, to rapid-dial and transfer 
calls to those extensions, as well as to pick up ringing extensions. 
The BLF icons tell you at a glance whether an extension or line is 
idle, busy, ringing or in Do Not Disturb. See page 34 for a list of the 
icons and their meanings.

If the BLF feature is unavailable—either because it was not enabled 
when the console was installed or because the console has lost its 
connection with the 3300 ICP—the  icon at the top of the Status 
column in the BLF area will appear dimmed ( ). In addition, no BLF 
status icons appear next to the BLF entries, indicating that they are 
"Not Monitored."

You can add and remove extensions and lines or change extension 
and line order in the Edit BLF List dialog.

Note: You can use the BLF feature list to call extensions even if the 
feature is disabled.

To display the Busy Lamp Field

• Press the BLF key on the console keypad (use the Options 
command on the Tools menu to program a BLF key to the key-
pad), or

• Click the Busy Lamp Field icon ( ) on the tool bar, or

• Click the Tools menu followed by Busy Lamp Field.

To sort the Busy Lamp Field

Sort the BLF list columns to find column entries more easily. Name, 
Department and Location columns appear in alphabetical or inverted 
alphabetical order. Sorting is not supported for BLF ( ) or Private 
( ) columns.

• Click the column header once to sort, again to invert the sort 
order, and a third time to unsort the information.

Note: “Unsorted” order is the order in which you built the list using 
the Edit BLF List dialog.

Searching the Busy Lamp Field

You can quickly locate an entry in the BLF list by matching search 
values (numbers, words, or the first few letters of a word) to entries 
in the BLF columns. 

To search the Busy Lamp Field

You can search by name, number, department, or location:

1. Click  and select a column to search from the drop down list. 
(The default search column is Name.)

2. Type a search value in the field beside the  icon.

For example, if you search for “John Smith”, enter values such as

• S, J – Last name, First name 

• J S – First letter(s) of first name and last name

• Smi – First letter(s) of either the last or first name

As you type, the search function searches for the first matching 
entry, then selects and displays the entry in the list.

If what you have typed does not match any entries, the search 
box turns yellow and a message indicates no matching entries.

3. If you make an error, press ESC, BACKSPACE, or DELETE to 
clear the search box.

4. Click  to navigate to the next entry or  to move to the 
previous entry. 

If your search reaches the top or bottom of the list, the search 
list wraps and the console alerts you with a message in the status 
area and an audible alert.

5. Press ENTER to dial the selected extension from the search list

or
Press [New Search] to begin a new search.
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Calling, Transferring, and Picking Up Calls in the Busy Lamp Field
To dial an extension, use any of these methods

• Select an entry, then press [Call].

• Select an entry, then press ENTER on the keyboard.

• Double-click any entry.

To transfer a call to an extension in the Busy Lamp Field area

• Dial the extension, then press Release.

To pick up a ringing call

If a call is ringing an extension in the Busy Lamp Field (BLF) area, 
and the extension is busy, not answering, or you know that the called 
party is not available, you may wish to recover that call to speak to 
the caller directly.

With your console in idle state (that is, with no calls in either the Source 
or Destination areas):

1. Ensure that the  or  ringing icon is shown beside the 
extension.

2. Click once on the extension to select it.

Note: If you accidentally double-click the ringing extension, your 
console dials the selected extension rather than picking up the 
ringing call. Press Cancel to hang up on the extension.

3. Press [Pick Up].
Note: If one or more attendants is attending calls with you, be 
sure you don’t pick up a ringing call that another attendant has 
just placed.

Editing the BLF List

BLF lists are either local or shared. A local list is stored on the console 
PC for use from that console only. A shared list is kept on the network 
where other consoles can access it. All attendants can edit a shared 
list. The changes made at one console appear in all the others. Only 
one attendant at a time can edit the list. The attendant making 
changes sees them immediately; the other attendants see them only 
after they re-enter or refresh the Busy Lamp Field area.

Tip: If you know an attendant has made a change to a list you are 
both sharing, but the change is not showing on your screen, 
press BLF or the BLF icon ( ) to refresh the BLF list display.

To edit the BLF list

• Select Edit BLF List on the Tools menu. This dialog appears 
with the extensions available for monitoring on the left:

If an extension or line is missing, contact your administrator to have 
it added, then close and reopen the Edit BLF List dialog to see the 
extensions your administrator has added. Changes to Name, 
Department and Location of an existing monitor are updated between 
5 and 6 AM or if you exit and start the Console again.
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To add, remove, or reposition entries in the BLF List

1. Select the entry.

To select consecutive entries, click the first one, press and hold 
down SHIFT, and then click the last one.

To select non-consecutive entries, hold down CTRL while you 
click individual entries.

To search for an entry, type all or part of the name in the Find 
Names starting with box.

2. Do any of the following:

• Click Add to add the selection to the top of the BLF list, or 
Remove to delete it.

• Click Move Up or Move Down repeatedly until the selection 
is in the desired position.

• To quickly move an entry, hold the mouse button down on 
the Move Up or Move Down button.

3. Click OK.

Questions about the Busy Lamp Field
Tip: Create the BLF list with your favorites at the top of the list. They will 
always appear at the top when the list is unsorted.

What does the  icon mean?

When it appears next to an extension, it means that the extension is 
designated as private. Attendants see the name and number of the extension 
on their screens; other extension users see only “Private” on their display. 
You may not want to give out any information to callers about the status of 
locked extensions.

What do the icons in the  column mean?

These icons appear beside extensions. They indicate the following states:

idle phone, Do Not Disturb* off

idle phone, Do Not Disturb* on

ringing phone, Do Not Disturb* off

ringing phone, Do Not Disturb* on

busy phone, Do Not Disturb* off

busy phone, Do Not Disturb* on

Blank
(no icon)

Not monitored or cannot be monitored. The absence of icons 
next to all the BLF entries indicates that the console has lost 
connection with the 3300 ICP or has failed over to a secondary 
3300 ICP. The column header icon ( ) also dims when 
there a loss of connection or a fail-over.

* Do Not Disturb applies to extensions only.

Why do the BLF columns sometimes appear unsorted?

If you sort any of the BLF list columns and exit the Busy Lamp Field, the 
list remains in the order that you last specified. 

Because the list maintains the order that you last specified, it may 
appear “unsorted” when you re-enter the BLF area. 

To re-sort the list in an order that you prefer, simply click on the column 
header once or twice, until you see the desired sort order.
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Call Answering Priority
The console is usually set up to answer incoming calls on a ‘first-
come, first-served’ basis. When you press the Answer key with 
multiple calls waiting, the call that has been waiting longest will be 
answered first. Alternatively, you can assign priorities to calls based 
on their destination. For example, you might give higher priority to 
calls to your company’s main listed directory number (LDN) than to 
“Dial 0” calls (that is, internal calls to the console). 

Your communications department will tell you which type of call it 
prefers you to answer first.

Note: The Answer key has a hierarchy when the console is set up 
to answer calls on a first-come, first-served basis: recalls are 
answered first, followed by other calls either in order of call-answering 
priority, or in order of arrival. If more than one call is waiting at a 
particular softkey, those calls will be answered on a “first-come, first-
served” basis.

To specify which calls are answered first

1. Choose Options on the Tools menu.

2. Click Answer Priority.

3. Do one of the following:

• To answer calls on a first-come, first-served basis, select 
First-Come, First-Served.

• To prioritize calls by line, select Assigned line priorities 
and then enter a number from 1 to 7 for each line. The lower 
the number, the higher the answering priority.

4. Click Apply or OK.

Call Park
Provided the appropriate access code is programmed into the 
system, this feature allows an extension user to retrieve a call that 
you put on hold, by dialing the Call Park - Remote Retrieve access 
code, followed by the console identity number (the first two digits of 
the call ID value) and the hold position number (the last digit of the 
call ID value) displayed on your screen.

To park a call for retrieval by an extension user

1. Put a call on hold (see Holding and Retrieving Calls on page 23).
The screen displays the call in the first available Hold position:

2. Page the requested party, informing him or her of the hold posi-
tion number. For details on how to page, see page 45.

In the example above, assume that Jane Doe (hold position 2) 
wants to reach Mr. Lee. Assume that the Call Park - Remote 
Retrieve Code is 69. Page Mr. Lee in the following manner: “Mr. 
Lee, please dial 69 142.”

Mr. Lee (the called party) can then retrieve the call by dialing 69 
(Call Park - Remote Retrieve access code), 14 (the two-digit 
console identity number), and then 2 (the hold position number).

When the called party retrieves the call, the call is removed from 
the hold position on your screen.

Up to six calls can be parked at the console at any one time.
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Incoming Calls Threshold / Screen Pop
To reduce call-waiting times, your system may be programmed to 
present incoming calls to other consoles or answering positions. If your 
system is programmed this way, you can specify the number of calls 
that must be incoming before the system presents them to your 
console. 

Screen Pop is a feature that, when enabled, allows you to minimize 
the console window and have it 'pop up' when a call exceeding the 
Incoming Calls Threshold arrives.

To set the incoming calls threshold 

1. Choose Options on the Tools menu.

2. Click Miscellaneous.

3. Enter a number in the Incoming Calls Threshold box.

To enable or disable the Screen Pop feature

1. Choose Options on the Tools menu.

2. Click Attributes.

3. Click Yes to enable Screen Pop or No to disable it.

Questions about Call Park
What happens if the called party does not retrieve the call?

After a predetermined period of time, the call will automatically recall your 
console.

What happens if I change the status of the console to "Operator 
Absent" while I have parked calls?

The parked call will remain in the attendant hold position for the same 
predetermined period of time. This allows system users to retrieve calls 
parked at a console whose attendant just left. After the predetermined period 
of time, all parked calls (external and internal) are automatically routed to a 
programmed answering point.
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Cancel Call Forwarding
Call Forwarding lets an extension user route some or all calls to other 
extensions. You can cancel Call Forwarding on behalf of individual 
extension users, or for all extensions in the system.

To cancel all types of Call Forwarding for a single extension

1. Select Cancel All CFWD on the Program menu.

2. Enter the extension number using the computer keyboard.

3. Click Yes.

To cancel Call Forward - Follow Me for a single extension

You can cancel Call Forward - Follow Me on an extension and leave 
the other types of Call Forward (Busy and No Answer) alone.

1. Select Cancel Station CFFM on the Program menu.

2. Enter the extension number using the computer keyboard.

3. Click Yes.

To cancel all Call Forwarding for all extension users

1. Select Cancel All CFWD on the Program menu.

2. Click Yes.

3. Click Yes again to confirm the cancelling.

Clear All Features
From your console you can disable features activated on any 
extension in the system.

These are the features you can clear: 

• All Call Forwarding 

• Do Not Disturb 

• Callbacks to other users 

• Advisory Messages

• Auto-answer 

• Timed Reminder 

To cancel all features on an extension

1. Select Cancel Station Features on the Program menu.

2. Enter the extension number using the computer keyboard.

3. Click Yes.

Questions about Clear All Features
Will using Clear All Features on an extension have any effect on 
Messages or Callbacks set on that extension by other users?

No, it only affects features activated by the extension user. Any Message 
notifications or Callbacks set on the extension by others will still be in place. 
Similarly, Clear All Features will have no effect on the station user’s Account 
Codes or Class of Service.
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Customize the Queued Calls Displays
Each of the Queued Calls displays presents a variety of call 
information for incoming, held, or transferred calls. 

Depending how you customize your Queued Calls displays, each may 
display the following columns of call information:

• Call ID (Incoming, Held, or Transferred)

• Time and Total time that the call has been queued

• Caller’s name and number

• Notes - use this field to annotate held calls (see “Annotating 
Calls” on page 23)

• Line name or number that the caller dialed and that the call 
arrived on

•  icon indicates the privacy status of the destination

•  icon shows the BLF status of the destination

• For Name and Number show the name and extension of the 
person the caller is trying to reach (in Calls on Hold display)

• Transferred To shows the name of the person you transferred 
the call to (in Transferred Calls display)

• Department and location indicates the department and location 
of the person the caller wishes to reach

• Device type displays the caller’s device type, if the call is internal; 
or the trunk type that the call arrived on, if the call is external

• Hold order for held calls

Note: Some of the call information columns listed above are shown 
by default in the Queued Calls displays; others are hidden by default. 
You may wish to display or hide call information columns according 
to your call processing needs.

You can select which columns you wish to see. Customize this area 
to suit your needs by

• deleting and restoring columns

• resizing columns to show more or less information.

The ID column and those with icons as heading labels (Private and 
BLF Status) cannot be resized. All columns are removable except for 
the ID column; it and at least one other column must stay displayed.

To delete an unwanted column

1. Right-click the column header that you want to remove.

2. Click Remove This Column on the pop-up menu.

To restore a previously deleted column

1. Right-click any column header.

2. Click Select Fields on the pop-up menu. The Field Selection 
dialog box is displayed.

3. Check the columns that you want to have displayed.

4. Click OK.

Any columns that were previously hidden return to their fixed positions 
and default widths.

To resize columns

• Use the mouse and cursor to widen or narrow columns as 
required.
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Data Calls
You may be asked to connect an outside caller to a data connection 
for data communications.

To connect a caller to a modem

1. Advise caller to switch local modem to “Data” when they hear 
the high-pitched modem tone. 

2. Dial the modem number.

‘Modem Call’ appears in status area. 

3. Dial the destination data terminal number.

‘Ringing’, and then ‘Connected’ appear in the Destination area 
to confirm that you are connected. 

4. Listen for the high-pitched modem tone. 

5. Press Release to connect the caller to the modem.

If the number is busy or there is no answer, press Cancel to return 
to the caller in the Source area. 

To set up a local Associated Data Line call

1. Dial the Associated Data Line code.

If you hear silence, continue. 

If you hear busy tone, the Associated Data Line is in use, or is 
not ready. 

2. Dial the destination data terminal number.

‘Ringing’, then ‘Connected’ appear in Destination. Listen for 
Connect Tone. 

3. Press Release.

Your data line is connected. 

To set up an Associated Data Line Call to a remote facility

1. Dial the Data Access Code.

If you hear silence, continue.

2. Dial the modem hunt group number.

‘Modem Call’ appears in status area. 

3. Dial the remote data facility number.

‘Seized’, and then ‘Connected’ appear in Destination.

4. Listen for Connect Tone.

5. Press Release.

Note: For faster dialing using Phone Book, ask your communications 
department to add frequently dialed data numbers to the system 
directory.
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Day and Night Service
Office telephone systems are typically placed in Night Service after 
regular hours, or whenever the last available console is left 
unattended.

Calls then ring alternate answering points—either designated 
extensions, or a night bell. 

Extension users can dial the Trunk Answer From Any Station 
(TAFAS) Code to answer incoming calls ringing the night bell.

If the last available attendant console has not processed a call after 
a programmable time-out period, the system is automatically placed 
in Night Service 1.

To change the service mode

• Select the appropriate mode from the  list in the 
Console Status area.

Note: Contact your communications department for information 
about where the answer points are and when you should select the 
different services.

Do Not Disturb (Extensions)
Extension users usually set and cancel Do Not Disturb (DND) on their 
own phones but you may be asked to do it for them. When set, DND 
prevents calls from ringing the extension.

To set up Do Not Disturb on behalf of an extension user

1. Select Set Station DND on the Program menu.

2. Enter the extension number using the computer keyboard.

3. Click Yes.

To cancel Do Not Disturb on behalf of an extension user

1. Select Cancel Station DND on the Program menu.

2. Enter the extension number using the computer keyboard.

3. Click Yes.

To cancel Do Not Disturb for all extensions 

1. Select Cancel All DND on the Program menu.

2. Click Yes.

3. Click Yes again to confirm the cancellation. 

Questions about Day and Night Service
What services are affected by Day or Night Service?

The change from Day to Night service may effect some users depending on 
their COS and COR. For example, a user might have a COR that allows 
external calls when the system is in Day service but not when in it is in Night 
service.

Questions about Do Not Disturb
Why would an extension user want to use Do Not Disturb?

Do Not Disturb prevents most calls from ringing the extension. Only recalls, 
overrides, and special trunks dialing in directly to the extension will ring it. If 
extension users want protection from tone intrusion (for instance, during a 
data call) they should use Call Privacy instead.

What kind of tones does another extension user or attendant get when 
calling an extension that has Do Not Disturb set?

They hear slow busy signal. Anyone who is permitted to override the other 
extension may then do so.
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Emergency Calls
This feature raises an alarm at the console when an extension user 
places an emergency call and identifies the extension that placed the 
call. With this information, you can direct emergency services (for 
example, police or ambulance personnel) to the location from which 
the call was placed.

When an emergency call alarm is raised, the console rings and 
displays EMERGENCY CALL. The emergency call goes directly to 
emergency services; therefore, the attendant does not have an 
opportunity to verbally communicate with the person who initiated the 
emergency call.

To read an Emergency Call

1. Click  on the toolbar.

- or - 

Click Tools, and then click Emergency Call Log.

The Emergency Call Log window displays:

If emergency calls were previously cleared, they will appear in 
the Emergency Call Log, with the most recent call listed first.

2. Click Clear to acknowledge the call. EMERGENCY CALL disap-
pears when the last outstanding emergency call has been cleared. 

Note: Only one person can view the emergency call at a time.

To delete an Emergency Call 

1. In the Emergency Call Log, select the cleared emergency call 
you wish to delete.

2. Click Delete.

Note: Only cleared logs can be deleted. The 3300 ICP will retain all 
Emergency Call Logs.

To close the Emergency Call Log

• Click Quit.

Note: Once you exit the 5550 IP Console, all logs are discarded from 
the Emergency Call Log; however, the logs can be retrieved through 
the 3300 ICP.

Questions about Emergency Calls
What does the  icon on the toolbar mean?
It is the Emergency Call Log icon. To view the calls listed in the Emergency 
Call Log, click the icon once. 

What does the  icon in the Emergency Call Log mean?
Emergency calls appear in the Emergency Call Log, with the most recent call 
listed first. A current emergency call is marked with the  icon, while 
previous emergency calls are not marked with the icon; therefore, only 
emergency calls marked with the  icon can be cleared.

Sometimes I cannot view the current emergency Call details—why?
Only one person can view the current emergency call details at a time. Other 
attendants receive "Emergency Call Displayed by <extension>" in the 
response area at the bottom of their application. If another attendant is 
viewing the current emergency call details, you can still access locally 
cleared emergency call information, but you cannot access or clear the 
current call. 

Sometimes the Emergency Call Log disappears —why?
If you do not click Clear approximately 60 seconds after receiving the 
emergency call, the log reverts to Phone Book so another attendant can view 
the current emergency call details.

If another attendant doesn't acknowledge the emergency call, click the  
icon again to open the Emergency Call Log.



42 ♦ Advanced Features

Firmkey Programming 
You can reprogram the top two rows of keys on the console keypad 
with other features or remove a feature from a key if the feature is 
unavailable.

To program features to keys

1. Choose Options on the Tools menu.

2. Click Keypad.

3. Using the right mouse button, click on the key that you want to 
program. 

A list of features appears.

4. Select the feature you want to assign to the key.

5. Repeat steps 3 and 4 to program other keys.

6. Click Apply or OK.

To restore the original key programming

• Click Restore Defaults.

One Button to Voice Mail
You can program the Voicemail key on the console keypad for one-
button transfers to voice mail. 

1. Choose Options on the Tools menu. 

2. Click Voice Mail.
3. Under Enter Voice Mail System Number, enter the digits re-

quired to access your Voice Mail system. 

4. Under One Button to Voice Mail, enter the following 
information:

• Amount of delay (i.e. milliseconds) between the console 
sending the Voice Mail system number and the Voice Mail 
system responding. To ensure the system is ready to answer 
the call, a delay between Voice Mail system answer and 
console sending digits is required. The default is 1000 
milliseconds. 

• Digit(s) required to trigger the Voice Mail system to prompt 
for a Voice Mail box number. The default key is the pound 
key (#).

• Amount (i.e. milliseconds) of delay prior to sending the 
Voice Mail box number. The default is 1000 milliseconds.Questions about Firmkey Programming

What is an Unassigned key and why would I want to program one?
The Unassigned key allows you to program one or more firmkeys to be 
“blank”— in other words, the key does not launch any feature. 

You may want to program unassigned status to a key that you find you often 
press by accident — for example, if you frequently press the key beside 
Voicemail unintentionally, you can program that key to be “unassigned” so 
that you don’t repeatedly make the same dialing error.
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Message Waiting
You can set (activate) a message waiting indicator on an extension, 
to notify the user that you have a message for him or her. You can 
also check whether an extension has a message waiting and clear 
the message waiting indication.

If a dialed extension is busy, unanswered or has activated Do Not Disturb

1. Press [Source] and take the message.

2. Press Message.

3. Press [Set MSG Waiting].
4. You can then,

• press Cancel to return to the call in Source (if necessary), 
and then

• press Release to release the call in Source. 

To set message waiting if you are not currently connected or trying to connect 
with an extension

1. Press Message.

2. Press [Set MSG Waiting].
3. Dial extension number.

To cancel a Message Waiting indication

You can cancel a message waiting indication whether you are 
connected to the extension or not.

1. Press Message.

2. Press [Clear MSG Waiting].
3. Dial the extension number (if not connected to the extension).

To check whether an extension has a message waiting

1. Press Message.

2. Press [Check MSG Waiting].
3. Dial extension number.

The words “MSG Waiting ON” appear in the Destination area if the 
extension has a message waiting.

Questions About Message Waiting
How do extension users know there is a message waiting for them?

The indication depends on the type of telephone. A user with a standard 
telephone hears Message Waiting Tone upon lifting the handset. (If the user's 
phone has a message lamp, the light flashes). The LCD display on phones so 
equipped, shows a message waiting indication in addition to the tone.

When should I cancel Message Waiting notifications?

You can do it whenever it is convenient for you; however, it saves time and 
effort to do so at the same time as you deliver the message to the extension 
user.

While you are delivering the message to the extension,

1. Press Message.

2. Press [Clear MSG Waiting].
3. Press Release when you finish the call.
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Operator Absent/Present Status
You can change the Operator status to Absent when you plan to be 
away from your desk and do not want calls sent to your console. All 
new and waiting calls will ring another destination determined by 
system programming.

To change the Operator Present/Absent status

• Select the state you want from the  list in the Console Status 
area.

If you are the only Attendant on the system and you attempt to change 
the console status to Absent, a warning message will appear on your 
screen: ‘Absent Feature Disallowed for Last Attendant. Select Night 
Service.’ For more information about Night Service, see page 40.

Note: Unplugging the handset or headset will automatically change 
the Attendant Status to Absent. See Unplugging Handset or Headset 
on page 10 for more information.

Override
You can interrupt a busy extension or intrude on a busy outside line. 

To intrude on a busy extension

1. Press [Override].
All parties in the conversation hear Override Tone (a brief tone 
every six seconds) for as long as you are connected to the call.

Everything you say is overheard by all connected parties.

The message ‘Feature not allowed’ appears if your Class of 
Service does not allow you to override the extension.

2. After the override, you may,

• press Release to disconnect the console from the call.

Or

• press Cancel to reconnect to the call in Source and discon-
nect from the call in Destination.

To intrude on a busy trunk (outside line)

1. Dial Individual Trunk Access Code.

2. Dial trunk number.

For a list of trunk numbers, use the Trunk Group Status Display 
feature described on page 48.

3. Press [Override].
The callers hear Override Tone as long as you are connected to 
the call. When they hang up, the line is available for your use.

Questions about Operator Absent/Present Status
What happens to my calls when I activate Operator Absent?

All new and waiting calls to your console are automatically rerouted to 
programmed destinations. Calls that you may have put on hold will time-out 
and either be given reorder tone or redirected to the programmed 
destination. However, you can still originate calls.

Note: If a console has not processed a call after a programmable time-out 
period, the console status automatically changes to Operator Absent.
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Paging
If your system has paging equipment, you can use it to make 
announcements to one or more areas or “zones.”

Use the Paging Zones table in the Reference section to record the 
location of the paging zones.

To make a page

The Source and Destination areas of your screen must be clear.

1. Press Pager.
If you have only one paging zone, you will be immediately con-
nected to the pager.

2. Make your announcement. 

If you have more than one paging zone

• After pressing Pager, dial the 2-digit Paging Zone Code—(01-
15) or 00 for all zones.

Listen for a long beep. Once you are connected to the paging 
circuit, one of these messages appears on your screen: 

“Page Zone Busy” — someone else is accessing the paging 
equipment. Try again later, or press [Override] (if this is allowed 
in either your or the paging unit’s Class of Service) to interrupt 
the page in progress.

“Page Zone Unassigned” — you do not have access to that 
paging zone.

“Connected to Pager” — you are connected and can make your 
announcement.

To end a page

• Press Cancel or Release.

You are disconnected from the paging equipment.
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Phone Book
Use the Phone Book to search your system's telephone directory for 
people and extensions. You can search by entering a person's name, 
an extension number, a department, or a location. Searching by 
department is useful when a caller requests to speak to "someone in 
Sales" rather than a specific person. A location could be a conference 
room, the lobby of your building, or other place that has a phone. You 
can also make a call from the Phone Book.

To access your system directory

You can access the directory at any time.

1. Press Phone Book.

2. Type the person’s name or other information in the appropriate 
boxes. (Use the mouse or Tab to move between boxes.)

Press Backspace to erase incorrect keystrokes.

3. Press [Search] or ENTER.

Entries that match what you typed appear in the Phone Book area.

4. Scroll through the list by clicking the  or  buttons, or press-
ing the Page Up/Page Down keys on the keyboard.

5. Click the desired entry to select it.

6. Press [Call] or ENTER to call the selected entry.
You can also double-click the entry to call it.

7. Press [Hold For] to hold an incoming or held call for the selected 
entry.

Note: Pressing [Hold For] automatically annotates the held call 
with the name, number, department, location, and BLF status of 
the selected Phone Book entry.

8. Press [New Search] to begin a new search.

Questions about Phone Book
What does the  icon mean?

When it appears next to an extension, it means that the extension is 
designated as private. Attendants see the name and number of the extension 
on their screens; other extension users see only “Private” on their display. 
You may not want to give out any information to callers about the status of 
locked extensions.

What do the icons in the  column mean?

These icons appear beside extensions. They indicate the following states:

idle phone, Do Not Disturb* off

idle phone, Do Not Disturb* on

ringing phone, Do Not Disturb* off

ringing phone, Do Not Disturb* on

busy phone, Do Not Disturb* off

busy phone, Do Not Disturb* on

Blank
(no icon)

Not monitored or cannot be monitored. The absence of icons 
next to all the BLF entries indicates that the console has lost its 
connection to the 3300 ICP or has failed over to a secondary 
3300 ICP. The column header icon ( ) also dims when 
there a loss of connection or a fail-over.

* Do Not Disturb applies to extensions only.



Advanced Features ♦ 47

Scratch Pad
The Scratch Pad is your own personal phone directory and Speed 
Dial list. Use it to save telephone numbers for faster dialing or to store 
the names and numbers of callers for future reference. 

To enter information into the Scratch Pad

You can use the Scratch Pad while connected to a caller.

1. Press Scratch Pad.

2. Type a name, a telephone or extension number, and any other 
information you want to save. 

Include the Outside Line Access Code for external phone num-
bers and omit spaces between digits.

3. Press [Save] to save the information.

To delete information in the Scratch Pad

• Select the information using the mouse or the arrow keys, and 
then press Delete.

To dial a telephone number in the Scratch Pad

• Select the number you want to dial, and then press [Call].

Serial Call
If a caller wants to talk to several people in a row, use the Serial Call 
feature. When the first call ends, the caller returns to the console 
instead of being disconnected. You can then dial the next call. The 
serial call keeps returning to the console until all the intended calls 
have been made. 

To set up a serial call for a caller in the Source or Destination area:

1. Tell the caller to remain on the line after completing each call.

2. Press [Set Serial Call].
3. Dial an extension number. 

4. Press Release.

The console is released from the call. When the extension you 
dialed hangs up, the Serial Call returns to the console as a Recall 
(see Recall on page 27).

To cancel a Serial Call

• When the caller has finished the series of calls, press
[Cancel Serial].
If the serial call recalls and no one is there, it means the caller 
has hung up.
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Trunk Group Status Display
Trunk Group Status Display is an optional feature that lets you monitor 
traffic on the system. During peak traffic periods, some users could 
experience problems making external calls and may contact you to 
find out why. The Trunk Group Status Display feature enables you to 
confirm excessive traffic as the most likely cause. You can then tell 
users that the situation is temporary and suggest that they try making 
their calls later. 

You can display traffic information by specifying trunk group numbers 
or the digits dialed to access them—for example, the digit 9. 

The use of this feature does not disrupt call processing.

To display traffic information by trunk group number

1. Press Trunk Status.

2. Select Search by group number.
3. Enter the starting trunk group number, and then

press [Search].
The displays show a list of the trunk groups, the number of trunks 
in each group, and the number of those trunks currently in use 
—for example, 

The Timestamp shows the time of your last search. 

To display only the information on the trunks that are accessed by dialing a 
given leading digit string 

1. Press Trunk Status.

2. Select Search by dialed digits.

3. Enter the leading digit string—for example, area code “416.” 

4. Press [Search].

After displaying traffic information you can...

• Click [Print] to print status information for the displayed trunk 
groups only.

• Click [Print All] to print status information for all trunks groups, 
including those not displayed. 

Options
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System Speed Call
Frequently dialed telephone numbers may be saved for you and other 
extension users for speed dialing. Use the table provided in the 
Reference section to record the System Speed Call numbers you will 
most likely need.

• Dial the System Speed Call Number. 

The stored telephone number is dialed automatically. 

Notes: 

• If you find that you are frequently dialing the same numbers, add 
them to your personal Speed Call list in the Scratch Pad. For 
more information, see page 47. You can also use the Bulletin 
Board to store speed call numbers for use by all attendants. For 
more information, see page 31.

• Programming system speed call numbers is done by your com-
munications department and cannot be done from the console. 

Tone Signaling
You may have noticed that when you dial a number at your console, 
you don’t hear any of the tones or pulses normally associated with 
telephones. You don’t hear tones because your console 
‘communicates’ with the rest of your telephone system with different 
types of signals. 

However, there are times when you need to send tones in order to 
complete your call. Typically, special services such as voice mail 
require passwords or other information in the form of tones before 
allowing access.

To generate tones

Once the connection is made and you are prompted to enter digits: 

1. Press Tones.

The Tones indicator in the Console Status area appears dimmed 
when tone signaling is turned off.

2. Dial the code.

To turn off tone signaling

• Press Release
to disconnect your console from the call. Tone signaling stops 
automatically.

or

• Press Tones again to turn off the tones.
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Displaying and Changing Room Information
Room information includes guest name, room occupancy and 
condition status (Vacant, Clean, Out of Service, etc.), outgoing call 
charges and restrictions, and the status of message waiting, wake-
up call, and other guest services. 

To display, enter, or change room information 

You can display, change, or enter new room information while the 
console is idle, or when you are on a call to the room.

1. Press Guest Service, or if you are already on a call to the room, 
press the [Guest Service] softkey.

2. Enter the room extension using the computer keyboard (not nec-
essary if you are already on a call to the room). The display looks 
similar to the following:

In this example, John Smith from I.T. is checked into room 1205 
and can make internal calls only. He has a Wake-up call set for 
06:00. The room is occupied and being cleaned (“Maid 
Present”), and the extension is affected by Call Blocking.

Note: The information displayed is different depending on 
whether the console is connected to a room or a suite — see, 
About Suite Services below for details. 

3. Make the required changes (if any), and then press [Save] to 
save them.

About Suite Services
Suite Services provides optional Shared Telephone Service (STS) to all 
phones in interconnected hotel/motel rooms or suites. When STS is 
operating for a particular suite, calls to the suite ring all phones. Wake-up 
calls, Message Waiting, Do Not Disturb and Call Blocking also apply the 
same to all phones. When operating without STS, each phone acts 
independently allowing, for example, guests in a two-bedroom suite to set 
separate wake-up calls. 

How can you tell whether the console is connected to a room or a suite 
and whether STS is operating?

When connected to a suite with STS operating, the Telephone section of the 
Guest Services screen will show the number and name of the calling or 
answering extension as follows: 

The upper part of the Guest Services screen will show the primary suite 
number-that is, the number used to call the suite and for check-in and 
check-out

If STS is not operating, the Number box in the Telephone section is 
activated, allowing you to select a phone and set up a wake-up call for it.
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After displaying the room information, you can...

• Enter or change the name of the guest and the company or group 
he or she is affiliated with. The guest’s name can have a maxi-
mum of 20 characters.

• Check the guest in or out (see page 55).

• Change the room’s occupancy or condition status (see page 55).

• Enter, change, or clear the wake-up call time (see page 55).

• Set or change outgoing call restrictions (see page 56).

• Allow or block room-to-room calling (see page 57).

• Clear the Message Cost and information for calls placed from 
the room (see page 58).

Note: Guest Services shows only whether Do Not Disturb (DND) or 
Message Waiting (MW) are on or off. For information on changing the 
status of these features, see page 40 and 43.

Searching for Rooms
You can search for a room using the occupancy and condition states 
as search parameters. This enables you to find, for example, all rooms 
that are vacant and clean or that have maids in them. You can also 
search using a guest’s last name to determine which room they are in. 

To search for rooms

1. Press Guest Service.

2. Do one of the following:

• To display information for a specific room, use the computer 
keyboard to type the room number in the Room Number box.

• To find rooms by occupancy and condition status, click 
Room Status, and then select states from the Occupancy 
and Condition lists.

• To begin searching from a particular room, type the number 
of the room in the Starting at room box.

• To find a guest’s room, click Last Name of Guest, and then 
type the guest’s last name. 

3. Press [Search].

4. To view information for a room in the list, click to select it and 
then press [Select]. Use the arrow keys or the Page Up and 
Page Down keys to scroll through the rooms. 

If a printer is attached to the console, you can print the occupancy 
and condition status for all rooms in the hotel or motel. For more 
information, see Printing Reports on page 58.

Options
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Changing Room Occupancy and 
Condition Status

The room occupancy and condition states are as follows:

To change a room’s occupancy and condition status

1. Press Guest Service, or if you are already on a call to the room, 
press the [Guest Service] softkey.

2. Enter the room extension using the computer keyboard (not nec-
essary if you are already on a call to the room).

3. Press [Search].
4. Select the desired states from the Occupancy and Condition 

lists. 

5. Press [Save] to save the changes.

Note: Depending on system programming, all ‘occupied and clean’ 
rooms may automatically change to ‘occupied and not clean’ at a 
specified time each day.

Checking-In/Checking-Out
Checking in a guest changes the status of a room to Occupied; 
checking out changes the room to Vacant. Both check-in and check-
out clear the guest name, affiliation and wake-up time (if set). The 
Call Block and Call Restriction settings for the room are also reset to 
values specified by system programming.

To check in or check out a guest

1. Press Guest Service, or if you are already on a call to the room, 
press the [Guest Service] softkey.

2. Enter the room extension using the computer keyboard (not nec-
essary if you are already on a call to the room).

3. Press [Check-In] or [Check-Out].
4. Press [Save] to save the changes.

To cancel changes you made and return to the previous screen, 
press [Previous].

Setting and Clearing Wake-up Calls
Both you and the guest can set, change, and cancel wake-up calls 
for a guestroom. The system does not distinguish whether a wake-
up call is set, changed, or canceled from the console or guestroom 
telephone. So, for example, a guest can cancel a wake-up call that 
you set and vice-versa.

Wake-up calls can be set to occur up to three times a day with or 
without daily repetition. For each wake-up, you can specify whether 
the call is made by the system (an Automatic wake-up) or the 
attendant or other hotel employee (a Personal wake-up).

Occupancy Condition

Vacant
Occupied
Reserved

Clean
Not Clean
Maid Present (see note)
To Be Inspected
Out of Service

Note: The Maid status can also be changed from the room by 
dialing a code.
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To set, change, or cancel a wake-up time while viewing the guestroom’s 
information

1. For each wake-up call that you want to set up, specify the fre-
quency (once or daily) and method (automatically by the system 
or personally by a hotel employee) of delivery.

2. Click in the Wake-up box, and then type the hour and minutes 
in 24-hour format. You must enter four digits—for example 0630 
for 6:30 AM (or 1830 for 6:30 PM)

To cancel a wake-up call, delete the time from the Wake-up box.

3. Press [Save] to save the changes.

To set, change, or cancel a wake-up time when NOT viewing the guest room’s 
information

1. Press Guest Service.

2. Enter the room number using the computer keyboard.

3. Follow steps 1 and 2 from the previous procedure.

Notes:

• If the guest fails to answer the wake-up call, the system will ring 
the room up to four more times at intervals of two to seven min-
utes. If the guest still does not answer, the wake-up call could 
be routed to the console.

• Some display phones can set their own timed reminder. The 
above procedures will also clear or change a reminder already 
set by the user.

• If a printer is attached to the console, a report may print each 
time you set, change, or cancel a wake-up call.

Setting Call Restrictions
You can control the type of telephone calls that guests can place from 
the phones in their rooms. There are three levels of call restriction: 
Internal, Local, and Long Distance. 

The system provides three more levels (labeled Option 1, 2, and 3) 
that can be used to impose special call restrictions. Ask your 
communications department for instructions about the use of these 
restrictions.

To set or remove call restrictions for a room

1. Press Guest Service, or if you are already on a call to the room, 
press the [Guest Service] softkey.

2. Enter the room extension using the computer keyboard (not nec-
essary if you are already on a call to the room).

3. Press [Search].
4. In the Call Restriction list, select one of the following:

• Internal to allow internal calls only.

• Local to allow internal and local calls.

• Long Distance to allow internal, local, and long distance 
calls.

• Option 1, Option 2, Option 3 to impose special call restric-
tions determined by system programming.

Note: Your system may be programmed to automatically change call 
restrictions for rooms at check-in and check-out time. 
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Blocking Room-to-Room Calls
Call Blocking stops guests from placing calls to other rooms. You can 
control when Clock Blocking takes effect and the rooms affected by it. 

To control whether Call Blocking affects a room 

1. Press Guest Service, or if you are already on a call to the room, 
press the [Guest Service] softkey.

2. Enter the room extension using the computer keyboard (not nec-
essary if you are already on a call to the room).

3. Press [Search].
4. In the Call Block list, select the option you want.

5. Press [Save].

To turn Call Blocking on or off for the entire system

1. Select Guest Services on the Tools menu.

2. Select Toggle Call Block.

The Call Block indicator in the Console Status area appear 
dimmed when Call Blocking is turned off.

Note: Your system may be programmed to turn Call Blocking on and 
off for all affected rooms at certain times of the day and for individual 
rooms at check-in/check-out time. 

Monitoring Guest Rooms
Guests can use their room phone as a listening device to monitor their 
room from a remote station. The remote station can be an attendant 
console, an extension, or an outside phone calling into the system on 
a special line (i.e., a DISA trunk).

To use the console to listen in on a room that has room monitoring activated

You can only monitor a room from an idle console.

1. Select Guest Services on the Tools menu.

2. Select Room Monitor.
3. Dial the room number using the console keypad.

4. Listen for three short beeps followed by audio from the room.

If room monitoring is not activated on the room phone, you will 
hear reorder tone or a beep. 

If you see ‘Monitor Busy,’ then another extension is already mon-
itoring the room.

If you see ‘Class Restricted’ or ‘Access Disallowed,’ then the 
room cannot be monitored because of restrictions on the console 
or the room phone.

To disconnect the console from the room

• Press Cancel or Release.
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Clearing the Message Register
The message register is a record of the number and cost of all external 
calls placed from a guest room telephone. The system uses meter 
pulses received from the local telephone company to calculate costs. 
If pulses are not received, then only the number of external calls are 
counted.

A guest’s message register is automatically cleared when the guest 
is checked out. If a guest prefers to pay for calls on a daily basis, you 
can manually clear the register after each payment is made.

To display or clear a room’s message register

1. Press Guest Service, or if you are already on a call to the room, 
press the [Guest Service] softkey.

2. Use the computer keyboard to type the room number in the 
Room Number box (not necessary if you are already on a call 
to the room).

The Message Cost and Calls fields show the total cost and num-
ber of all external calls placed from the room.

3. Click Clear to erase the Message Cost and Calls totals. 

If a printer is attached to the console, a report may print showing the 
contents of the register before it was cleared.

Printing Reports
If a printer is connected to the console, you can request printed reports 
of message registers, room status and automatic wake-up calls. 
Some reports print automatically. For example, whenever a wake-up 
call is set, changed, or canceled, a record of the event is printed.

To print a report

• On the Tools menu, select Guest Services followed by the com-
mand that corresponds to the report that you want to print.
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Alarms
Your telephone system uses automatic monitoring and fault diagnosis 
to check the system for faults. 

An alarm status appearing in the upper-right corner of the screen 
notifies you when a fault occurs. When there are no faults, this area 
is blank. If a critical alarm occurs, you’ll hear a recurring beep. 

The alarm display is cleared automatically when the fault is corrected. 

Alarm types

There are three classes of alarms: Minor, Major and Critical. 

MINOR

There is a minor alarm within the telephone system, which probably 
does not affect the telephone users. 

MAJOR

An alarm affecting service has occurred, but calls can still be made. 
Contact your communications department. 

CRITICAL

The telephone system is not providing normal service and should 
automatically switch itself to System Fail Transfer Mode (if this is 
available on your system). You MUST contact your communications 
department. 

Greetings
Record your company’s preferred greetings for each of the following 
situations.

Calls on Outside Lines

Calls On Inside Lines

Recalls

Calls Camped on to a Line

Taking Messages
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Rerouted Calls
Some users may decide to reroute their calls to your console, or the 
system may be programmed to reroute certain types of calls or all 
calls made at given times to your console.

The calls that are rerouted to your console may be one of
four types:

• Calls a user has forwarded (Follow Me, Busy or No Answer).

• Calls to a given number rerouted by system programming.

• Calls on certain trunks if incoming calls on certain trunks are 
always “transferred” to your console.

• If the user dials a number that is rejected by the system for any 
reason, Intercept Handling may be programmed to reroute the 
call to your console.

Call Forwarding

When a user has forwarded his or her calls to your console, incoming 
calls to that extension will ring your console. When you answer, the 
called party information will appear in the Destination area.

Note that the Destination area displays the name of the called party, 
the called party’s number, and the type of Call Forwarding that the 
called party programmed and that caused the call to be rerouted to 
your console (Follow Me, Busy or No Answer).

Also, two softkeys are always available in this situation: 
[Set Serial Call] and [Redial Dest]. Pressing [Redial Dest] will 
automatically redial the called party, overriding the Call Forwarding 
to your console.

System Rerouting

When the system is programmed to redirect calls to an extension to 
your console at all times, the message “Call Forward - Always 
Reroute” appears in the Destination area, below the user’s name and 
extension number.

Transferred Calls

If you transfer an incoming call to an extension, and the extension 
user transfers the call back to your console, the message 
‘‘Transferred’’ appears in the Destination area.

Intercept Handling

When a user dials a number that the system rejects, the call is 
rerouted to your console. When you answer, the appropriate Intercept 
Handling message displays in the Destination area. See System 
Messages on page 68 for information about the messages that may 
display in that situation.
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Class of Restriction
Each extension and trunk in the system is assigned a Class of 
Restriction. As its name implies, a Class of Restriction (COR) may 
restrict an extension (or a trunk) from accessing an external route at 
a given time. 

The extension’s COR is displayed in the Source or Destination area 
of the console screen, along with its Class of Service and the other 
information on the caller. 

Here are a few examples on how the Class of Restriction can affect 
users:

• The extensions with a given COR may not dial outside the sys-
tem at all, having to ask the assistance of the attendant
to do so. 

• Extensions with another COR may have to go through the atten-
dant in order to dial long distance. 

• Extensions with yet another COR may only dial certain long-
distance numbers and at given times of the day.

• Extensions with the least restrictions programmed could dial 
anywhere at any time. 

• The extension’s COR may change with Day, Night 1 and 
Night 2 services.

• Routing may change according to the time of the day and the 
day of the week, indicating different outside dialing privileges 
according to the time of dialing.

Class of Service
Not all the features described in this Guide are available on your 
console or on other extensions. 

An extension’s Class of Service (COS) appears, with the information 
about that extension, in the Source or Destination area of the console 
screen. 

Each COS defines which features an extension or console can 
activate. The message “Feature not allowed” appears on the console 
screen when you try to access a feature not allowed in your or the 
extension’s COS. 

Here are some examples of how a COS could affect users: 

• COS could change depending on whether the system is in Day, 
Night 1, or Night 2 Service.

• Extensions without an appropriate COS could be denied access 
to certain features, such as Call Override, Paging Access or 
Setting Message Waiting Notification.

• You and other extension users may be required to enter an Ac-
count Code for additional system access or when you want to 
use your COS at a different extension.

• Some extension users cannot be overridden.
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Feature Access Codes

FEATURE CODE

Account Code Access

  - Verifiable

  - Non-Verifiable

Associated Dataline Access 

Loopback

Call Hold

  - Retrieve

  - Remote - Retrieve 

Callback 

  - Cancel

Call Forward 

  - Busy (External)

  - Busy (Internal) 

  - Follow Me

  - Follow Me Enchaining

  - I Am Here 

  - No Answer (External)

  - No Answer (Internal) 

Call Park Remote Retrieve

Call Pickup

 - Dialed

 - Directed

Call Privacy 

Camp-on

  - Retrieve

Clear All Features

  - Remote

Conference

Do Not Disturb

  - Remote

  - Cancel Remote

External Line Access

Forced Release

Last Number Redial

Individual Trunk Access

Message Waiting Inquire

Message Notification

  - Cancel

Override

Paging

Personal Speed Call

  - Invoke

  - Store

TAFAS -Remote Retrieve

FEATURE CODE
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Glossary
Account Code

A code you dial to access certain system features; to apply your Class 
of Service (COS) at a different extension; or to associate a caller with 
an SMDR record for accounting purposes. 

ARS - Automatic Route Selection

This is an application that handles long distance call routing 
automatically.

Broadcast Group

When a line has an appearance on another telephone, it is said to be 
in a broadcast group. This means that all extensions with that line 
appearance have access to and may use that line. 

Call Privacy (Data Line Security)

A COS feature which prevents an extension from receiving Camp-on 
Tone -- which could interfere with data transmission. 

Camp-on

A feature allowing the system to queue calls directed to a busy 
extension, then automatically connects the waiting party to the 
extension when it becomes free. The busy extension user hears 
Camp-on Tone indicating a call is camped-on. The waiting caller is 
put on hold and hears music or silence. 

Class of Restriction (COR)

Control of a station or trunk’s access to trunk circuits. A station may 
have up to three different CORs specified for Day, Night 1 or Night 2 
Service. 

Class of Service (COS)

A level of service defined by a specific set of features that controls 
an extension’s access to these features. A station may have up to 
three different COSs specified for Day, Night 1 or Night 2 Service. 

Consultation Hold

A temporary hold applied to a call while an extension or console user 
activates a feature or makes a call. 

Direct Inward Dialing (DID)

This feature allows outside trunks to reach pre-programmed 
extensions directly, without going through the Attendant console. 

Direct Inward System Access (DISA)

A feature which allows callers to dial directly into the telephone system 
and activate features and facilities.

External Line Access Code

A code which precedes a dialed number to indicate to the telephone 
system that the telephone number is outside the system. 

Firmkeys

Keys on the console keypad that can be programmed to access 
console features and system services.

Hunt Group

Extensions linked together in a group with a common (pilot) telephone 
number as well as their own personal extension numbers. Two types 
of hunting are available with your telephone system: Circular Hunting 
and Terminal Hunting. 
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Circular Hunting: A new call to the Hunt Group is directed to the first 
idle extension found after the extension, which received the last call. 
This provides equitable call distribution to all the extensions.

Terminal Hunting: Hunting takes place in the order in which the 
extensions were programmed into the hunt group. It always starts 
with the first extension in the list and the hunting ends with the first 
idle extension found.

Line

A telephone communications channel between switching centers or 
the Central Office and the 3300 ICP. 

Night Answer Point(s)

An extension user can answer incoming calls ringing the Night 
Answer Point by dialing the TAFAS code. 

Night Service

A system mode of operation that routes incoming calls to the Night 
Answer Point(s) when the system is in Night Service and the 
Attendant consoles are in Absent mode. 

Pickup Group

Extensions located in one area, or with similar departmental functions, 
are often placed in the same answer group. 

Recall

A call returns to the console for further handling by the attendant. 

SMDR - Station Message Detail Recording

This is an application that automatically logs call information such as 
“length of call” and “caller extension number”, among other things.

Switchhook Flash

Used by extension users to signal the telephone system that they 
want to activate a feature. 

TAFAS Code

(Trunk Answer From Any Station) A code used to answer calls ringing 
the Night Answer Point(s). 

Trunk

An outside line which links two switching systems. This link can be 
between one or more private telephone systems and/or between your 
private system and the public telephone system (Central Office). 
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Hunt Groups
Dialing a Hunt Group Pilot Number either from the keypad or through 
the Phone Book feature, connects you to the first available extension 
in that area. Contact your communications department for more 
information

Paging Zones
Use this table to record the paging zones your system uses. Contact 
your communications department for more information. 

Pilot
Number Hunt Group Name Extensions

Location Zone Code

All Zones 00

01

02

03

04

05

06

07

08

09

10

11

12

13

14

15
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System Speed Call List System Messages
These messages appear in the various areas of your screen. 

Absent Feature Disallowed for Last Attendant. 
Select Night Service

As the last or only attendant in the group, you cannot place your 
console into absent mode. 

Access Disallowed

The feature access code you’ve dialed is not available to an 
Attendant. 

Attendant Gr(oup)

Displayed when one attendant calls another number belonging to one 
or more attendants. 

Broadcast Gr(oup)

Group of extensions sharing the same line. Actually, every line in the 
system is part of a broadcast group, even if it appears on only one 
extension (private lines, for example). 

Busy

The number you just dialed is busy. 

Callback - Recall

The busy extension or trunk you requested the system to monitor is 
now available.

Callback Queue Full

Your request for a Callback has been denied because of insufficient 
system resources.

Name Number
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Call could not be picked up.

The call has been picked up by another attendant, answered at the 
ringing extension, or the caller has hung up.

Call could not be recovered.

The call cannot be retrieved either because it has been answered at 
the extension, or the caller has hung up. 

Call Forward - Always Reroute

This extension user has all calls rerouted to you. 

Call Forward - Busy

This extension user is busy and has forwarded calls (Call Forward - 
Call Fwd Busy) to you. 

Call Forward - Follow Me

This extension user has all calls forwarded to you (Call Forward - 
Follow Me). 

Call Forward - No Answer

This extension user is not available, and has forwarded calls (Call 
Forward - No Answer) to you. 

Cancel All Features for Station # :

Enter the number of the extension for which you wish to cancel all 
features. 

Cancel CFFM for Station # :

Enter the number of the extension for which you wish to cancel Call 
Forward- Follow Me. 

Cancel Do Not Disturb for All Stations ... Completed

Confirms that the requested action has been taken. 

Cancel DND for Station # :

Enter the number of the extension for which you wish to cancel Do 
Not Disturb. 

Cancel Forwarding for All Stations ... Completed

Confirms that the requested action has been taken. 

Cancel All CFWD for Station # :

Enter the number of the extension for which you wish to cancel all 
types of Call Forwarding. 

Canceling Do Not Disturb for All Stations

Your request is in progress. 

Canceling Forwarding for All Stations

Your request is in progress. 

Cannot Activate Feature if a Party in DESTINATION

Release party in DEST and try again. 

Cannot Put Connected Party On Consultation Hold

You already have a party on Consultation Hold, and you cannot 
perform certain functions - for example, activating message waiting 
for an extension until you clear the destination field. 

Check MSG Waiting for Station # :

Enter the number of the station for which you want to check the 
message waiting notification(s). 
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Completed

Confirmation message when the number you’ve entered is valid and 
the action requested has been taken. 

Class Restricted

Your Class of Service does not allow this feature. 

Conference

Indication that a conference has been set up or is on hold.

Connected

Confirmation message when your call is connected to a data call. 

Connected to Pager

Confirmation message that you have accessed the paging zone and 
can make your announcement. 

COR

Indicates the Class of Restriction applicable to that station or trunk. 

COS

Indicates the Class of Service applicable to that station or trunk. 

COS Violation

The caller tried to access an unavailable feature. Intercept handling 
has rerouted the call to your console. 

Data Line

Equipment name displayed when a data line is called. 

Data Group

Equipment name when a data group is called. 

Directory Number Out of Service

The caller has dialed a directory number that does not exist. The call 
has been rerouted to your console. 

Do Not Disturb

The extension user you dialed has activated Do Not Disturb. You 
cannot call this extension unless you use the override feature.

Error in loading the Busy Lamp Field configuration file.

The file that stores the BLF list entries cannot be accessed. Contact 
your system administrator.

External

Indicates a call from outside your system (a trunk call). 

Feature Activated

A feature such as Do Not Disturb is activated. 

Feature Cancelled

A feature such as Do Not Disturb is cancelled. 

Feature Not Allowed

There is a restriction preventing you from using this feature, or 
performing this action. 
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Guest Service

Part of the Hotel/Motel Feature package. This prompt appears in 
several attendant mode operations. Pressing it places the console in 
Guest Service mode immediately. 

Headset or handset required for attendant operation

Plug in your headset or handset. 

Holding Party Locked Out

You have left the caller on Key hold for too long, and the call is 
returning to your console. 

Hunt Group

Indicates that a station or trunk is a member of a hunt group. 

Interconnect Failure

There are local interconnect restrictions which do not allow you to 
connect the requested devices. 

Interconnect Restriction

The caller’s extension is programmed with Interconnect Restriction. 
Intercept Handling has rerouted the call to your console. 

Internal

Indicates a call from inside your system. 

Invalid Account Code

Verify your Account Code and try again. 

Invalid Dialing

Verify what you dialed and try again. 

Invalid Number

You attempted to dial an incorrect number. Verify your number and 
try again. 

Invalid Trunk Number

You attempted to select an incorrect or out-of-service trunk. 

Language selection option not installed

The language you requested is not installed on your telephone 
system. 

Locked out

Indicates a station which is out of service and cannot be accessed or 
make a call. 

Modem

You are connected to a modem. 

Modem Busy

The modem dialed is already busy. 

Modem Call

Confirmation message when you dial a modem. 

Modem Group

Indicates that the modem you are connected to is in a group of 
modems. 

Modem Out of Service

The modem dialed is out of service and cannot be used at this time. 
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Monitor Busy

The extension you are trying to monitor is already being monitored 
from another station.

MSG Waiting

After pressing the [Check MSG Waiting] softkey, this indicates that 
the extension has message(s) waiting.

MSG Waiting OFF

Confirmation that you turned off an extension’s message waiting 
indicator by pressing the [Clear MSG Waiting] softkey.

MSG Waiting ON

Confirmation that you turned on an extension’s message waiting 
indicator by pressing the [Set MSG Waiting] softkey.

Must CANCEL before dialing

Press Cancel on the console keypad, and the try dialing again.

Network

Shows if you have dialed over a MSDN/DPNSS (Digital Private 
Network Signaling System) line, which connects 3300 ICPs in a 
private network. 

No Answer

There was no answer at the extension called. 

No call to answer at specified incoming position

Verify your Incoming Calls display. Another attendant may have 
answered the call while your list was “frozen”, or the caller may have 
hung up.

No call to retrieve at specified hold position

Verify your Calls on Hold display. Another attendant may have 
transferred the call while your list was “frozen”, or the caller may have 
hung up. 

No call to retrieve at specified transferred position

Verify your Transferred Calls display. Another attendant may have 
transferred the call while your list was “frozen”, or the caller may have 
hung up. 

Not Ready

The data call cannot be completed at this time. Try again later. 

Operator Absent

If you have changed the status of your console to Operator Absent, 
this message is displayed in the DEST area of the console of another 
attendant who calls you. 

Out of Service

The device you dialed is not in service. 

Overriding

Confirmation message when you override a busy party. 

Page Zone Busy

The zone number you dialed is busy; dial another zone code, or try 
again later. 

Page Zone Unassigned

Verify the number you dialed. If it still doesn’t work, contact your 
communications department. 
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Press “Yes” to Confirm Request or “No” to Quit

Press the appropriate softkey. 

Recall

A previously extended call has returned to your console after a time-
out period. 

Recall – Busy

A previously extended call has returned to your console because the 
extension is busy. 

Recall - Busy, Camp-on Not Allowed

There is a restriction preventing you from camping a call on to the 
requested destination. 

Recall – No Answer

A previously extended call has returned to your console because the 
extension did not answer. 

Remove MSG Waiting for Station # :

Enter the number of the extension from which you wish to remove a 
Message Waiting notification. 

Request Denied

Verify what you’ve just done, and try again. 

Request ignored. Must press Retrieve key then digit key associated with ID to 
retrieve call.

Try again, but press Retrieve followed by the call ID digit associated 
with the call (1-6).

Ringing

The number you dialed is ringing. 

Route

You are calling a route. 

Seized

Confirmation message when you access a trunk. 

Select Paging Zone

Enter the number of the zone which you wish to access by
the Pager. 

Selected Operation Not Being Acknowledged. Request is Abandoned

The telephone system is not processing your request. Try again later 
or verify your operation. 

Selected Trunk

Indicates that a particular trunk has been selected for use. 

Serial

Indicates a caller who wants to talk to several people in succession. 

Serial - Busy

The Serial call has returned to your console because the destination 
is busy. 
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Serial - No Answer

The Serial call has returned to your console because the destination 
did not answer before a predetermined period of time.

Serial - Recall

The Serial call you made was successful. 

Set MSG waiting for Station # :

Enter the number of the extension on which you wish to set a Message 
Waiting notification. 

Setup DND for Station # :

Enter the number of the extension for which you wish to set up Do 
Not Disturb. 

SUPERSET x...x

The station in question is a SUPERSET telephone. 

5550 IP Console

You are connected to another 5550 IP Console.

System is in Night Service 1

The call has been rerouted because the system is in 
Night Service 1. 

System is in Night Service 2

The call has been rerouted because the system is in 
Night Service 2. 

System Unable to Complete Selected Operation. Please Try Again

The telephone system is not processing your request. Try again later. 

Toll Denial - Illegal Dialing

The caller dialed a toll number wrong, and the call has been rerouted 
to your console. 

Toll Denial - Route Restriction

The caller tried to dial a toll number not allowed in his/her Class of 
Restriction and the call has been rerouted to your console. 

Tone Timer Expired

You’ve been listening to busy or ringing tone for too long and the 
system has disconnected your call. Cancel the call and try again. 

Transferred

The call has been transferred from an internal extension. 

Trunk Access Denied

You are not allowed access to the trunk because of your or the trunk’s 
Class of Restriction. 

Unable to Setup or Add to Conference

Either: 

• there is a restriction in your COS/COR preventing you from set-
ting up a conference; 

• you have reached the maximum number of trunks allowed in a 
conference; 

• you have reached the maximum number of conferees allowed 
in a conference; or 

• you cannot have two attendants in a conference. 
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Unassigned Directory Number

The number you dialed is not recognized by the telephone system. 
Verify your number and try again. 

Wake-up Call Not Acknowledged

Part of the Hotel/Motel Feature package. The guest has not answered 
the automatic wake-up. (Note: The Hotel/Motel package is an optional 
feature.) 

Wake-up Call - System Error

Part of the Hotel/Motel Feature package. The Wake-up function is not 
operating properly. Contact your communications department. 

You are already using the selected language. Language not changed.

You made a mistake in selecting the language. Repeat the procedure.

Telephone Directory

Name Number
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Trunk Numbers
Use this table to record the trunk numbers your system uses. Contact 
your communications department for more information about the 
trunk numbers.

Trunk Number Use
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Index

A
Answer calls 11
Answering priority, changing 35
Application area 4
Associated data line 39

B
BLF 32
Bulletin Board 31
Busy Lamp Field 32
Busy number, transfer to 20

C
Call Answer Priority 35
Call Block 57
Call Forwarding, canceling on extensions 37
Call Park 35
Call restrictions, setting for guest rooms 56
Callback 18
Cancel

All features on extensions 37
Call Forwarding on extensions 37
Do Not Disturb on extensions 40
Message Waiting on extensions 43

Check-in/Check-outSee Guest Rooms 55
Class of Restriction 63
Class of Service (COS) 63
Clear All Features 37
Close consoleSee 8
Conference calls 26
Console

Adjustments 9
components 3
Keypad 6
Keys 6
Language 10
Ringer 9

Screen 4
Starting and closing 8
Time 10

COR (Class or Restriction) 63
COS (Class of Service 63

D
Data Calls 39
Day and Night Service 40
Dialing telephone numbers 18
DND 40
Do Not Disturb 40

E
Extend callsSee Transfer calls 20

F
Features, clear all 37
Firmkeys, programming 42

G
Guest Room

Condition status, change 55
Display/change room information 53
Occupany status, change 55

Guest room
Find rooms 54

Guest Rooms
Call Blocking 57
Call Restrictions for 56
Check-in/Check-out 55
Message Register, clear 58
Monitoring 57
Reports, printing 58
Wake-up calls 55

H
Handset 7

Enabling 9
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Volume, adjusting 9
Headset

Enabling 9
Volume, adjusting 9

Hold, place call on 23
Hunt Groups 67

K
Keypad, console 6

L
Language, changing on console 10

M
Message Register, clearing for guest rooms 58
Message Waiting 43
Monitoring

Guest Rooms 57

N
Night and Day Service 40

P
Paging Zones 67
Park, Call 35
Phone Book 46
Programming Firmkeys 42

R
Recalls 24, 27
Recover, last call released 27
Rerouted Calls 62
Retrieve

Calls on hold 23
Ringer

Mute 9

Volume, adjusting 9
Room-to-room calls, blocking 57

S
Scratch Pad 47
Screen Pop 36
Serial Call 47
Sofkeys 7
Softkeys 3, 4
Speed Call, System 49
Start console 8
Status area 4
Status Display, Trunk Group 48
System Messages 68
System Speed Call 49
System Speed Call List 68

T
Telephone Directory 75
Telephone numbers, dialing 18
Time, setting 10
Tone Signaling 49
Traffic MonitoringSee Trunk Group Status Display 48
Transfer calls 20
Trunk Numbers 76
Trunks

Direct access 19

V
Voice Mail, One Button to 42
Volume

Headset/Handset, adjusting 9
Ringer 9

W
Wake-up callsSee Guest Rooms 55
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